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Getting Started
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How to Install Live Chat on Your Website in 5
Minutes
Follow these steps to install live chat on your website:

Step 1. Click “Sign Up” on the ProProfs Chat website, it will take you to the sign-up form, fill out the

form to set up your account.

Step 2. After completing the form you will be redirected to the chat window settings, navigate to the

"Installation" tab where you will get the chat code.  

Copy this code and paste it in all the web pages of your website just before the </body> tag.

https://www.proprofs.com/chat/signup/
https://chathelp.proprofs.com/visitor-chat-window-settings
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You can also send instructions to your developers by clicking "Send instructions to developer."You can also send instructions to your developers by clicking "Send instructions to developer."

 

 

Integrate with CMS

ProProfs integration with numerous CMS platforms allows you to add live chat on your website and offer

seamless customer support.

 

Integrate with Ecommerce

Integrate with numerous ecommerce platforms to install live chat on your website, boost your sales and offer

delightful customer support. 

 

 

 

 

 

Related Articles:Related Articles:

https://chathelp.proprofs.com/cms
https://chathelp.proprofs.com/e-commerce
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How do I Take a Product Tour?How do I Take a Product Tour?
How to Add an Operator?How to Add an Operator?
How to Add My Company Logo?How to Add My Company Logo?

 

https://chathelp.proprofs.com/overview
https://chathelp.proprofs.com/how-to-invite-an-operator---how-to-add-an-operator
https://chathelp.proprofs.com/how-to-add-your-logo-to-the-chat-window
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How to Add/Delete an Operator
Add customer support operators to your site, so your visitors are never short
on assistance. Operators can track real-time visitor activity on your website through the Visitor
Monitoring Window and provide exceptional support through the Visitor Conversation Window. 
Live chat operators are the solution to providing 24/7 interaction with customers. A Live Chat
Support Operator is responsible for answering queries and assisting customers through chat.
Here's how your operators will appear in your dashboard:

Follow these steps to learn how to add or delete an operator:
Step 1:  Click "Operators."

Step 2:  Manage Operators tab loads up, click "Add Operator" to invite a new operator. You can
also delete an existing operator by clicking the delete icon for that operator.

Step 3: Fill out the required information and click "Save." A pop-up message will confirm
operator addition.   

https://chathelp.proprofs.com/visitor-monitoring-window
https://chathelp.proprofs.com/visitor-monitoring-window
https://chathelp.proprofs.com/operator-s-chat-window
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More Live Chat Customization Options

Video About: How To Customize Your Live Chat Window

Related Articles:Related Articles:

How to Install Live Chat on Your Website?How to Install Live Chat on Your Website?
How do I Take a Product Tour?How do I Take a Product Tour?
How to Add My Company Logo?How to Add My Company Logo?

https://www.youtube.com/watch?v=eanb9XWa_KQ
https://chathelp.proprofs.com/how-to-install-live-chat-on-your-website
https://chathelp.proprofs.com/overview
https://chathelp.proprofs.com/how-to-add-your-logo-to-the-chat-window
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How to Add my Company Logo to the Chat
Window
ProProfs Chat allows you to upload your own logo and make your chat more credible. Adding your branding
to the chat window provides your visitors an intimate feel, like they are actually conversing with the brand. 
In addition to adding your logo, you can use several different tools when trying to raise your brand awareness
and one of those tools is the Chat Window Customization. 
Here's how your logo will appear in the chat window:

Follow these steps to add your logo to the chat window:
Step 1: Navigate to "Settings" -----> "Chat Window" -----> "Theme." Click to open the "Advanced" options.

https://chathelp.proprofs.com/visitor-chat-window-settings
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Step 2: Locate the "Logo" option and click "Browse." Upload your Logo's image and click "Save" to secure and
implement the changes.
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Related Articles:Related Articles:

How to Install Live Chat on Your Website?How to Install Live Chat on Your Website?
How do I Take a Product Tour?How do I Take a Product Tour?
How to Add an Operator?How to Add an Operator?

https://chathelp.proprofs.com/how-to-install-live-chat-on-your-website
https://chathelp.proprofs.com/overview
https://chathelp.proprofs.com/how-to-invite-an-operator---how-to-add-an-operator
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Tour Videos
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Brand and theme capability
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Overview of Settings
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Providing Instant Support
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Enable Anytime, Anywhere Support
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Reports and Analytics
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Customize Live Chat Window
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Integrate Chat with Knowledge Base
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Settings
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Departments
With ProProfs you can direct chats to specific departments (for example, Sales or Support) in order
to streamline help service.
Once you enable departments, a department drop-down list will appear in Visitor Chat Window  (pre-chat
form). This allows visitors to choose which department they want to chat with, resulting in a more
streamlined approach. 
If you don't want to display department in pre-chat form, you can also use the department specific live chat
codes on different web pages of your website.
Here are the steps to add departments to your ProProfs Chat: 

Step 1: Log in to your chat dashboard. 

Step 2: From the header menu navigate to “Operators” -----> "Departments" 

Step 3: Enable the department feature by switching the toggle button to “Yes.” Click the "Add Department"
button to create a department.

Step 4: Fill out the form, select the visibility and click on “save”. (refer to the screenshot below)
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Note* The departments will only be shown to visitors if the "Visibility" is switched to "Yes". 

Step 5: To directly send chats to the specific departments copy the chat code of the department and place it
under the ProProfs chat code on your website/webpage. 
(i) Click "Show Code" button to access the department's chat code.

 
(ii) Copy the chat code (highlighted part in the below example).
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Note* After enabling chats for departments, make sure the existing operators are assigned to a
department. Otherwise, the operators will not be able to handle any chats.

Related Articles:Related Articles:

Add Canned ResponsesAdd Canned Responses
Visitor Monitoring WindowVisitor Monitoring Window
Visitor Conversation WindowVisitor Conversation Window

https://chathelp.proprofs.com/add-a-pre-defined-canned-responses
https://chathelp.proprofs.com/visitor-monitoring-window
https://chathelp.proprofs.com/operator-s-chat-window
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How Do I Add Canned Responses in Live Chat?
Reply to the same customer questions with canned responses and save valuable time and effort. Save
answers to common questions to shorten your response time and save keystrokes on repetitive typing. With
canned responses, you type it once, save it and reuse it in chats and tickets whenever you need. 
 
Canned responses are predefined messages displayed to the operators with the intent of answering repeated
questions consistently. It helps the operators with swift assistance to the customers, operators can search
for particular canned responses through the search box.
 
Examples:
 
Welcome Messages

Thanks for your patience and for the opportunity to serve you. How may I assist you?
Thanks for the opportunity to chat with you. May I help you?
Hi! I notice that you are looking for specific information on our web site. May I assist you with your search
or direct you to the appropriate page?

 
Anything

Is there anything else I can assist you with?
Can I be of any further assistance?
Please do not hesitate to get in touch with us if you have any more questions. Is there anything else I can
assist you with?

 
Thanks

Thank you for having visited our web site. We hope you will come back again.
Thanks for chatting with me. I hope I was of assistance to you. Thank you.
Before I say Good Bye I want you to know that we are always standing by to assist you in any way
possible. Thanks.

 
Confirmation:

I have just responded to your query and I hope it meets with your satisfaction. Are you still with me?
 
Here's how the Canned Responses appear to the operator in the Visitor Conversation Window:
 

https://www.proprofs.com/chat/canned-responses/
https://chathelp.proprofs.com/operator-s-chat-window
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Here's how to add canned responses in live chat:
 
Step 1: Navigate to "Settings"-----> "General Settings" -----> "Canned Responses."

Step 2: To add a new canned response click "Add New."
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Step 3: Customize your canned response, you can also select responses from the library and add them to
your account.

Here's how the library of pre-defined messages will appear, select an appropriate message and click "Save" to
add it to your live chat.
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Operators can also save any specific response in their conversation with a visitor as a cannedOperators can also save any specific response in their conversation with a visitor as a canned

response. To learn more read response. To learn more read Visitor Conversation WindowVisitor Conversation Window..

How do I Delete/Edit Canned Responses?
To edit or delete canned responses, navigate to the specific response and click the edit or delete icon.

Related Articles:Related Articles:

Separate Chat WindowSeparate Chat Window
Visitor Chat Window SettingsVisitor Chat Window Settings
Auto Chat InvitationAuto Chat Invitation

https://chathelp.proprofs.com/operator-s-chat-window
https://chathelp.proprofs.com/separate-chat-window
https://chathelp.proprofs.com/visitor-chat-window-settings
https://chathelp.proprofs.com/pro-active/auto-chat-invitation
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Real Time Visitor Monitoring
Video About: How to Enable Anytime, Anywhere Customer Support

Visitor Monitoring Window displays the list of visitors on your website along with details
like geographical location, IP address, time spent on the page, and the web page they are
currently on.
Here is how a fully functional real-time visitor monitoring  window will look like:

To start monitoring  visitors, follow these steps: 
Click "Launch Chat" on the dashboard. Your "Real-time visitor monitoring window" will pop up in
a new tab. 

Once the real time visitor monitoring window appears, you can see all the details and perform
the associated actions. 

Details

https://www.youtube.com/watch?v=VzycUl-IXZk
https://www.proprofs.com/chat/real-time-visitor-tracking/
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Actions 

Details:                                                 
General Details1.

Advanced Details2.

Operators3.

General Details:
On the real-time visitor monitoring window, you can get the details of the following:
Name - By default, the visitors are depicted as "Visitor" in the order they visit the website. Once
the visitor fills in the pre-chat form to chat with an operator, the name will appear under the
"Name" column. 
Email -  When visitors fill out the pre-chat form, their email is visible along with the names under
the "Name" column.  
Status - The status column shows you what the visitor is doing on your website. A visitor could
be either browsing, chatting or leaving the website. All statuses are depicted with an icon. You
can hover over the icon to see the status. 
Duration - It shows the duration of a visitor on your website. 
Page - The page tells you the exact URL a visitor is browsing. 
Advanced Details:
Click visitor's name to access their advanced details:

Browser - It shows which internet browser the visitor is using. (for example Chrome, Firefox,
etc.)
Operating System - It shows which operating system the visitor is using. (for example Windows,
iOS, etc.)
Device Platform - This shows which device the visitor is using to browse your website. (for
example Mobile, Tablet, Desktop, etc.)
Operators:
Here's what you can see in the operator column:
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Online - Check which operators are online. 
Offline - Check how many operators are offline.
Engaged - This shows how many operators are engaged in a conversation with a visitor. 

Actions:

You can perform the following actions from your real-time visitor monitoring window:
Invite a visitor to chat - Click the "Invite" button and invite a visitor to chat by prompting an
automated greeting. Once the visitor accepts the invitation, the visitor chat window will open.
Monitor chats between operators and visitors - You can check if a visitor is already in a
conversation with an operator. You can join the conversation anytime and monitor the chat in
real time. (This feature is only accessible to administrators)
Chat with an operator - You can start chatting with an operator anytime by clicking the name of
the operator you want to chat with.

Related Articles:Related Articles:

Pre Chat FormPre Chat Form
Customize Offline MessagesCustomize Offline Messages

https://chathelp.proprofs.com/pre-chat-form
https://chathelp.proprofs.com/customise-offline-message
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How to Set up the Maximum Wait Time?How to Set up the Maximum Wait Time?

https://chathelp.proprofs.com/how-can-i-set-up-the-maximum-wait-time
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Visitor Conversation Window
Visitor conversation window is equipped with all the essentials to provide exceptional support to your
customers. With ProProfs Chat, you can track user's activity, transfer chats and much more via the operator’s
chat window. 
Here are the steps to get you started:

Step 1: Login to your ProProfs Chat dashboard.
 
Step 2: From your dashboard, click on “Launch Chat.” 

Step 3(i): Once you click on “Launch Chat,” real-time monitoring window will appear. This window will show
you all the visitors currently on your website. You can click “Invite,” to pop an automated greeting on the
visitor's screen and initiate chat. When your invitation is accepted by the visitor, the operator chat window will
open(as depicted in Step 4).  

Step 3(ii): On the visitor monitoring window administrators can access ongoing chats between a visitor and
an operator by clicking the "View" button.

Step 4: Any operator engaged in a conversation with a visitor does so through the visitor conversation
window. Here's a preview:
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What can operators do through the conversation window:
Operators can do the following:

Add tags

View visitor details

Send canned responses

View visitor activity

Share instant links with push URLs

Transfer chat to other operators

Block visitors

Add Tags: Operators can assign tags to the ongoing chat by clicking the "+ Add Tag" button at the bottom left
their window, and selecting the appropriate tag to add. Operators can also search for a tag or create a new
one using the search bar.  To learn more about tags read 'Tickets and Tags.'

https://chathelp.proprofs.com/tickets-and-tags
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Visitor details: You can see the visitor details such as Name, Email, Location, etc. The details allow you to
know what browser, operating system and device the user is using.  Under the details section, operators can
find options to End Chat, view previous chat transcripts and transfer the chat. 

Canned Responses: Canned responses help the operators with swift assistance to the customers, operators
can search for particular canned responses through the search box.
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Activity: You can see which product or page the visitor is browsing or have browsed while navigating through
the website. 



Live 2 support help
ProProfs Chat FAQs Settings

Copyright © 2014 ProProfs Page 34

Push URLs: You can save links ready to be sent to a visitor at any anytime. This will save the operator’s time
in escorting visitors to the pricing page or any other relevant pages. 
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Transfer Chat: Operators can use the "Transfer Chat" option to transfer the chat to any other operator. 

Block Visitor: Click "Block this visitor" to block the visitor. Once blocked, the visitor won’t be able to visit the
website with the same IP address.
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Related Articles:Related Articles:

Redirect Chat to Specific DepartmentsRedirect Chat to Specific Departments
Add Canned ResponsesAdd Canned Responses
Visitor Monitoring WindowVisitor Monitoring Window

https://chathelp.proprofs.com/departments
https://chathelp.proprofs.com/add-a-pre-defined-canned-responses
https://chathelp.proprofs.com/visitor-monitoring-window
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What are Announcements?
ProProfs LiveChat allows you to notify visitors about upcoming products, features and service
updates. Since announcements can be displayed on every web page that has LiveChat
integrated into it, announcements help reach a wider audience than a website's notification
page. It greatly improves customer service and can reduce customer tickets. Announcements
can also be used to redirect users to newly created or updated self-help articles.
The following article will guide you through the following:

How to Add an Announcement in ProProfs LiveChat

The Announcement Editor Window

This is what an announcement looks like.

How To Add An Announcement In ProProfs LiveChat

Step 1: Go to Settings---->Greetings.

https://www.proprofs.com/chat/
https://chathelp.proprofs.com/integrations
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Step 2: Next, Select the Announcements tab and click on Create Announcement.

Step 3: Name and edit your Announcement according to your requirements and click on Save.

Note: The name of the announcement can be seen only by you.Note: The name of the announcement can be seen only by you.

The Announcement Editor Window

Given below is the Announcement Editor Window.
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On-Off Button:
The On-Off button is used to toggle the display status of the Announcement.
If-Then Condition
The 'If' part is used to determine the conditions under which the announcement will be
displayed. You can add multiple conditions with the Add button.

When using multiple conditions the 'Any' and 'All' clause can be toggled as per requirement.
Under the 'All' clause, the announcement is displayed only when all the given conditions are
fulfilled. Under the 'Any' clause, the announcement is displayed even if one condition is true.
The text box next to 'Then' is used to write the text that will be displayed to the visitor.
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Button
The button option is used when the announcement is being used to redirect to a different page.
The 'Text' box is used for writing the text the button will display and the 'Link' is where the
redirection link can be placed.

Image
The image option is used when the announcement contains an image.

Display Settings
The display settings are used to determine the time period of an announcement's display, its
position in the webpage and the number of times it will be shown to the visitor.
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Separate Chat Window
ProProfs Chat allows you to either embed chat on your website or launches it as a separate
chat window. Here's how live chat appears in a separate chat window:

Follow these steps to install ProProfs Chat on your website: 
Video About: How To Add Live Chat Software to Your Website in Under 5 Mins

Step1. From your dashboard, click on "Settings."

Step2. On the sidebar, click "Installation."

Step3. Click "separate chat window". (see screenshot below)

https://www.youtube.com/watch?v=T_B58avEgj4
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Step4. Customise the Online and Offline chat text and click "Get code". Copy the code from the
text box and paste it before the </body> tag.   

Step5.  Paste the code in </body> tag of the page you want your live chat to pop up. Here's how
live chat will appear:
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Related Articles: 
 
Visitor Chat Window Settings

Auto Chat Invitation

Pre Chat Form

 

https://chathelp.proprofs.com/visitor-chat-window-settings
https://chathelp.proprofs.com/pro-active/auto-chat-invitation
https://chathelp.proprofs.com/pre-chat-form
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What Is Join Chat Functionality?
Join Chat is an administrator exclusive feature available in ProProfs Live Chat. With this feature,
you can read chats between customers and operators in real time. You can also interfere in a
chat conversation and provide insight into customer questions.
Benefits of Join Chat Functionality:

Allows you to monitor chats.

You can provide solutions to customer questions that the operator fails to solve.

It lets you personally assess the problem-solving skills of an operator.

How to Use Join Chat Functionality

Step 1: Log in to your ProProfs Live Chat administrator account and go to your Chat dashboard.
Step 2: Under the 'Action' tab, click on the Join option to join the operator chat.

Related: 
How to route chat to another operator?
How do operators enable automatic chat acceptance?
What are Announcements?

https://chathelp.proprofs.com/chat-routing
https://chathelp.proprofs.com/how-can-operators-enable-automatic-chat-acceptance
https://chathelp.proprofs.com/what-are-announcements


Live 2 support help
ProProfs Chat FAQs Settings

Copyright © 2014 ProProfs Page 45

Visitor Chat Window Settings
Video About: How to Customize Your Live Chat Window

Make chat window an integral part of your website using live chat customization. Create a
seamless support experience for your site visitors with powerful chat window settings. Change
the shape and style of your chat icon to help it blend well with the theme of your website.  
Here’s what all you can do with visitor chat window:

Theme

Settings                                        

Language

Pre Chat

Post Chat

Offline Messages

Theme
Here you can change the chat window design by providing various color and font options, you
can make sure that your brand logo is visible in the chat window.
Follow these steps to change the theme of your chat window:

Step 1:  Navigate to "Settings" -----> "Chat Window" -----> "Theme." 
Step 2: You'll see a sample chat window on the right and options to change the color and theme
of chat window on the left. Select a style(bubble or bar) and then select icon and theme color.

https://www.youtube.com/watch?v=eanb9XWa_KQ
https://www.proprofs.com/chat/customization/
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Step 3: Scroll down to change your avatar and logo, you can upload your own image for both. In
"Advanced" options you can customize the visitor and operator text color, chat box position and
size, and do the CSS customization.
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Step 4: Click "CSS Customization" in advanced options, a textbox with CSS code would appear
(see screenshot below). Make changes as per your requirement and click "Save."
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Settings
You can enable emoticons in chat window settings to make the conversation more engaging for
your site visitors. Also, allow your operators and site visitors to share files during a live chat.
The software settings allow you to send a chat transcript automatically to operators once a
session ends.
Let's look at how to customize the chat window settings:
Step 1: Navigate to "Chat Window" -----> "Settings."
Step 2: The settings section has two sub-divisions, navigate to the 'Chat Window' tab and enable
the desired options, every option provides brief descriptions to help you understand the feature. 
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Step 3: Similarly, switch to Real-Time Monitoring tab and enable desired options. Click "Save" to
secure and implement the changes.
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Language Customization 
You can delight visitors by providing support in their native language. Switching from one
language to another has never been this easy. All you have to do is visit the language settings,
click the drop-down option and choose the language that your operators will be using while
providing support to your site visitors. The tool also allows you to customize languages based
on the visitor’s location.
Follow these steps to change the language settings:

Step 1: Navigate to "Chat Window" -----> "Language."

Step 2: To add new languages click "Add New Language."

Step 3: Select the language you want to add from the list and choose the status of the

language.  Click "Save."
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Step 4: When you are done adding languages, you can customize the language settings which

are divided into three categories. 

(i): Chat - Language settings for live chat. Refer to the screenshot.

(ii): End Chat - These messages will appear once the chat with a visitor is over. 
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(iii) Call back - These messages are shown to the visitors when they request a callback. 

Step 5: Click "Save" to secure the changes.

Note* Note* The text of all the messages can be changed as per your language change andThe text of all the messages can be changed as per your language change and
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requirement. requirement. 

Pre Chat Form
With ProProfs, you can easily edit, customize or disable pre-chat form on your website. To get to
Pre chat form settings, click on “Settings” from your dashboard and hit “Pre chat Form” under
“Chat Window.”  
Navigate to "Chat Window" -----> "Pre Chat Form." Enable the form and customize the options.
Click "Add field" to include more fields to the form. Click "Save" to implement the changes. 

Here's how the form will appear, subject to your customization:
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Post Chat Form
With ProProfs, you can add a post chat survey for your visitors, which allows you to gather
invaluable feedback.
Navigate to "Chat window" -----> "Post Chat." Enable the form to customize a post chat form for
your visitors. To gather instant feedback, you can set up custom fields.
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Embed your survey:
Gather essential feedback by embedding a survey on the chat window which will appear to the
visitors after the chat is over. Enter the survey URL and click "Save" to secure the changes. Visit
ProProfs Survey Maker to create your own survey!

https://www.proprofs.com/survey/register/
https://www.proprofs.com/survey/register/
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Here's how the survey will appear to the visitor:

Offline Messages
You can set up an offline message form for visitors when your operators are not active. Visitors
can fill this form and live chat reps can connect with them later. Offline message form is fully
customizable, and you can edit or add fields according to your business needs.
To edit the offline message form, follow these steps:
Step 1: Navigate to "Chat Window" -----> "Offline Message"
Step 2: Set up the custom fields for the offline message. You can add, edit or delete any field as
per your requirement.
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Step 3: Offline Survey Form URL
You can embed your own survey as an offline message. Enter the URL of the survey in the box
and click "Save" to implement the changes. Create any desirable survey with ProProfs Survey
Maker and include it as an offline message for your visitors. 

https://www.proprofs.com/survey/register/
https://www.proprofs.com/survey/register/
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Here's how the survey will appear to the visitor in the chat window:

Related Articles:Related Articles:

Customize Offline MessageCustomize Offline Message
Auto Chat InvitationAuto Chat Invitation
Pre Chat FormPre Chat Form

https://chathelp.proprofs.com/customise-offline-message
https://chathelp.proprofs.com/pro-active/auto-chat-invitation
https://chathelp.proprofs.com/pre-chat-form
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Invitation Pop-up
Invitation Pop-up allows you to invite a visitor to chat. This feature can help you assist your website
visitors when they need you to solve their queries.
Follow these steps to set up an invitation pop-up:
Step1. Log in to your dashboard and navigate “Settings.”

Step 2. Under the “Advanced” section, click “Invitation Pop-up.”

Step 3. Enable 'Auto Invitation' to automatically send out chat invites to every visitor landing on your website.
Manually enter 'Time Delay' which is the duration of time after which invitation will pop-up. Select 'Invitation
Action,' you can choose to pop-up the chat invite on every page the visitor visits or once for each visitor
session.
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Step 4. Select the pop-up invitation style. Chat window will pop-up the conversation window while
invitation pop-up will pop the 'chat with us icon' as visible in the screenshot below. Click "Advanced"
button to customize the settings and click "Save" to implement the changes.

 
Step 5. From the advanced options, you can enable the pre-chat form for the proactive chat window.
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Customize placement, icon type, border size & color, invitation close time and sound. Click "Save" to
secure the changes.

 
 
 

Related Articles:Related Articles:

Customize Offline MessageCustomize Offline Message
Visitor Chat Window SettingsVisitor Chat Window Settings
Pre Chat FormPre Chat Form

https://chathelp.proprofs.com/customise-offline-message
https://chathelp.proprofs.com/visitor-chat-window-settings
https://chathelp.proprofs.com/pre-chat-form
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Pre-Chat Forms
ProProfs Live Chat provides the Pre-Chat Form feature that enables you to collect user
information which can later be used to create potential leads, cases, and contacts. These
PreChat Forms can be easily created, edited and customized. 
Here's what a pre-chat form looks like:

How To Enable A Pre-Chat Form

Step 1:  Go to Settings. Under Chat Window, select Pre Chat.

Step 2: Next, Enable Pre-Chat Form.
Step 3: Once you have customized a Pre-Chat Form, click Save.
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Customizing A Pre-Chat Form

The Pre Chat Form Editor has been shown below.

Header: The header is the text that appears at the top of the chat window.

Screen Message: The screen message displays a welcome message to the user.

Submit Button: Allows you to enter the text that will be shown on the submit button.
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Add Field: The Add Field button is used to add custom fields to a pre-chat form. The Add
Field opens a new dialog box where you can enter the type of field you need, the name of the
field, and whether or not the field is required. When the field is required, you can display a
validation message.
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Post-Chat Forms
ProProfs Live Chat provides the 'Post-Chat Form' feature which allows you to collect user
feedback after a chat is over. The feedback can later be used to assess the abilities of your
operators who handled the chat and the overall quality of the live chat service provided by you.
Here's how a post-chat form looks like:

How to Enable Post-Chat Form

Step 1: Go to Settings. Under Chat Window, select Post Chat.
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Step 2: Toggle the Enable button to Yes as shown in the image above to enable the Post-Chat
Form
Step 3: Once you have customized your Post-Chat Form, Click on Save.

Customizing a Post-Chat Form

Here's a view of the Post-Chat Form Editor
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Survey Text/ Custom Survey: The Survey Text option lets you create a custom feedback
survey with the editor shown above. With the Custom Survey option, you can link to an
existing survey from ProProfs Survey Maker.

Post Rating Message: This option lets you change the text above the rating bar.

Email: This is the Email ID to which all the feedbacks will be sent.

https://www.proprofs.com/survey/
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Submit Message: Enter the message that you want to display to the user after they click on
the submit button.

Placeholder Text: Enter the placeholder message that is displayed to the user in the
feedback text box.

Submit Button: Enter the text that you want to see on the submit button.

+Add Question: It is used to add custom fields to a post-chat form. The +Add Question opens
a new dialog box where you can enter the type of field you need, the name of the field, and
whether or not the field is required. When the field is required, you can display a validation
message.

Related: 
Pre-Chat Forms
Visitor Conversation Window
What Is Join Chat Functionality?

https://chathelp.proprofs.com/what-are-pre-chat-forms
https://chathelp.proprofs.com/operator-s-chat-window
https://chathelp.proprofs.com/what-is-join-chat-functionality
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Customize offline message
 Customize offline message window with this option. You can add multiple fields like visitor email,
name, phone number etc.
You can also use your own offline message window. Enter the URL of your personalized offline message
window.
Follow the steps below to customize offline message:
Step 1- Log in to your Control Panel
Step 2- Click on Settings on your dashboard page

Step 3- Click on Offline Message under the Chat Window, this will open the Offline Message Form.

Step 4- Fill in the required details in the blank fields provided.
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Step 5- Click +Add Filed to add custome fields in the Offline Message Form
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Step 6-  Fill in the details of the custom fields in the given text boxes and click Save.
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Step 7-  Click Advanced in order to include additional information.

Step 8-  Click Save to customize your offline message
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You have succesffuly customized your offline message. 

More Live Chat Customization Options

Video About: How to Customize Your Live Chat Window

Related Articles:Related Articles:

Add Canned ResponsesAdd Canned Responses
Auto Chat InvitationAuto Chat Invitation
How to Set up the Maximum Wait Time?How to Set up the Maximum Wait Time?

https://www.youtube.com/watch?v=eanb9XWa_KQ
https://chathelp.proprofs.com/add-a-pre-defined-canned-responses
https://chathelp.proprofs.com/pro-active/auto-chat-invitation
https://chathelp.proprofs.com/how-can-i-set-up-the-maximum-wait-time
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How do I Set up the Maximum Wait Time?
Admins can set the maximum time duration for a visitor's chat to accepted.
Here's how to set the maximum wait time:
Navigate to "Settings"----->Chat Window "Settings" -----> "Real Time Monitoring" and select "Yes" for "Maximum
Wait Time," enter wait time in seconds in the field provided and click "Save."

Here's how the chat window will appear to the user during the 'maximum wait time.' The user can click "Leave
a message" to directly go to the offline message form and skip the remaining waiting time.

https://chathelp.proprofs.com/customise-offline-message
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How to enable auto logout
ProProfs Chat allows you to set-up auto logout for your operators, so the operators automatically log out of
the live chat at the specific time or after the set period. 
Auto logout is a helpful feature that allows your operators to leave their dashboard without worrying about
any unanswered chats.  
For example, if you have set the auto logout for 5:30 PM, your operators will automatically become inactive at
5:30 PM, in case there is an ongoing chat which is not over by the set time, the operator will log out as soon
as the chat is over.
Here's how you can enable the auto-logout feature:
Navigate to "Settings"----->Chat Window "Settings" -----> " Real Time Monitoring" and select "Yes" for 'Auto
Logout.' Set a specific time or period for the setting and click "Save" to implement the changes.
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Start your no-obligation, free trial for ProProfs Chat today!

Try it Free Take A Tour

Related Articles:Related Articles:

Add Canned ResponsesAdd Canned Responses
Auto Chat InvitationAuto Chat Invitation
Visitor Chat Window SettingsVisitor Chat Window Settings

https://www.proprofs.com/chat/signup/
https://www.proprofs.com/chat/tour/
https://chathelp.proprofs.com/add-a-pre-defined-canned-responses
https://chathelp.proprofs.com/pro-active/auto-chat-invitation
https://chathelp.proprofs.com/visitor-chat-window-settings
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Reports
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Introduction to Reports
 
 
 
 
 
 
 

Related Articles:Related Articles:

TimesheetsTimesheets
Website Traffic ReportWebsite Traffic Report
Visitor Chat TranscriptVisitor Chat Transcript

https://chathelp.proprofs.com/timesheets
https://chathelp.proprofs.com/visitor-reports
https://chathelp.proprofs.com/visitor-chat-transcript
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Summary
Video About: How to Monitor Your Chat Operator Performance

Reports display graphs and tabular data, giving you an overview of your chat and
operator activity. The data is intended to help you optimize your customer support strategy and
improve its efficiency.
The summary report answers all prominent questions related to your chat and operator activity
and helps you analyze your team's performance.
Here's how you can access the summary report:
Log in to your chat account and navigate to the "Reports" tab. Summary is the default report
that loads up. 

The summary reports allow access to data which answers questions like "How busy are we?"
where you can view data for specific time periods and particular operators.  
Total Chats: This section provides incoming chat data. You can view data for total 'Daily,'
'Weekly,' or 'Monthly' chats.

Total Chats Rated: You can view data for how many of the incoming chats are being rated.

https://www.youtube.com/watch?v=9-fdJC8ociE
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Chat Ratings: Data revealing what ratings have the chats been receiving. It helps in analyzing
the quality of chat support.  

Missed Chats: Data for how many chats were missed by the support staff. It helps in analyzing
the efficiency of your chat support.
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Response Time: Data for how much time did the operators take on average to respond to a chat
request. 

Active Status: Representation of data for the total duration when your operators were active.  
Total Chat Time:  Data for how much time have your operators spent being engaged in chats.
Average Time of Chat Sessions: Data representing the average time for a chat session.  

Chat Summary

It offers comparative data for chat requests, accepted chats and missed chats.  

The chat summary data is also available in a tabular form. Click the "Tabular View" button
marked by the arrow in the below image. 

Here's a preview of the tabular view of chat summary. You can download the entire data on your
local hard drive. 



Live 2 support help
ProProfs Chat FAQs Reports

Copyright © 2014 ProProfs Page 82

You can view chat summary for a particular day by clicking the "View" button. 

Chat summary for a particular day lists all chats for the day, you can download this data, view
the transcript for any chat session by clicking the "View" button and access the 'Hourly Report.'

Here's a preview of how the hourly report would appear. You can also view this data in the
tabular form.



Live 2 support help
ProProfs Chat FAQs Reports

Copyright © 2014 ProProfs Page 83

Related Articles:Related Articles:

TimesheetsTimesheets
Visitor ReportsVisitor Reports
Operator Performance ReportsOperator Performance Reports

https://chathelp.proprofs.com/timesheets
https://chathelp.proprofs.com/visitor-reports
https://chathelp.proprofs.com/operator-performance-reports
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Chat Rating Report
Video About: How to Monitor Your Chat Operator Performance

The Chat Rating Report displays the rating given by a visitor to an operator after a chat session.
This helps in evaluating the operators' performance and helps them to work on areas of
improvement.
Here's how you can access chat rating report:
Navigate to the "Reports" tab from your dashboard, and select "Rating."  

Chat Rating: It provides a graphical data for the average rating recieved in a day. You can
choose to view this data for the weekly and monthly average rating. Also, you can select to view
the particular report of an operator.

Operator Rating: It shows the average rating of your operators, and helps in analyzing their
performance.

https://www.youtube.com/watch?v=9-fdJC8ociE
http://www.proprofs.com/chat/reports-and-analytics/
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Overall Average Rating: It provides the average rating maintained by your support team, and
also how many chats were rated 'five stars,' 'four stars' and so on. 

Recently Rated Chats: Tabular data for every rated chat. You can download this data and also
view the chat transcript for all rated chats. 

 

Related Articles:Related Articles:

TimesheetsTimesheets

https://chathelp.proprofs.com/timesheets
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Visitor ReportsVisitor Reports
Operator Performance ReportOperator Performance Report

https://chathelp.proprofs.com/visitor-reports
https://chathelp.proprofs.com/operator-performance-reports
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Operator Performance Reports
Video About: How to Monitor Your Chat Operator Performance

The operator performance reports provide you with insightful data to analyze the performance
of your operators. You can use the performance reports to identify which operators aren't
working efficiently and also provide necessary feedback to them.
Here's how you can access the operator performance report:
Navigate to the Reports tab and select Operator.

Operator Performance Report:  It provides data for all operators. Various sections of the
performance reports are explained below.

Operator: The name of the operator.
Requests: The number of requests that have been received by the operator.
The Accepted and Missed section specifies exactly how many requests were fulfilled and how
many were missed.
Rating: The rating section displays the average rating the operator has received. Green color
signifies a good rating, Orange signifies an average rating and red signifies a bad rating. The
ratings can help you identify which operators need help.
Rated Chats: This list specifies how many visitor chats rated the operator. Sometimes low rated
operators might have a better operating record than a high rated operator simply because more
of their chats have been rated. This number is an important factor when analyzing operator
efficiency.
Response time: The average time an operator takes to respond to a request. 

https://www.youtube.com/watch?v=9-fdJC8ociE
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How To Leave Feedback For Your Operators

Giving Feedback to low-rated operators and transcripts is important. The following steps will
show you how to do exactly that.
Step 1: Go to Transcripts----->Visitor Chat. 
This displays the latest fulfilled requests and also how much an operator has been rated. Click
the View button to view the transcript between your operator and visitor.

Step 2: The window that opens shows you the details of the visitor and also the chats between
the visitor and your operator.  Click the Edit Rating icon.

Step 3: You can leave feedback in the internal note section for your operator in the section.
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The feedback can be seen by your operator under the Reports tab in the Rating section. It
appears as a small message cloud next to the rating. Hovering over it shows your comments.

Related Articles:Related Articles:

SummarySummary
Visitor ReportsVisitor Reports

Chat Rating ReportChat Rating Report

https://chathelp.proprofs.com/reports-summary
https://chathelp.proprofs.com/visitor-reports
https://chathelp.proprofs.com/chat-rating-report
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Timesheets
Video About: How to Monitor Your Chat Operator Performance

Timesheet provides analytical data for operators' activities such as their login hours and active
hours. 
Here's how you can access timesheets for your chat account:
Navigate to the "Reports" tab and select "Timesheet." 

Timesheets provide you data for your operators' activities such as 'days logged in, 'login hours'
and 'active hours.' You can view and download data for any specific day or range of time for all
or any particular operator. 

Timesheets also provide specific data of every operator in tabular form. You can view operators'
active days, login hours, active hours, and efficiency(percent of active time out of total login
time). Click the "View" button to access a particular operator's timesheet.

https://www.youtube.com/watch?v=9-fdJC8ociE
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Here's a preview of the operator timesheet:

Related Articles:Related Articles:

Chat Rating ReportChat Rating Report
Visitor Chat TranscriptVisitor Chat Transcript
Operator Performance ReportsOperator Performance Reports

https://chathelp.proprofs.com/chat-rating-report
https://chathelp.proprofs.com/visitor-chat-transcript
https://chathelp.proprofs.com/operator-performance-reports
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Website Traffic Report
Video About: How to Monitor Your Chat Operator Performance

Website traffic report provides data for the number of visitors your website is attracting.
Here's how you can access the visitor reports: 
Navigate to the "Reports" tab and select "Visitor."

Here's a preview of the website traffic report. It provides monthly data for total visits to your
website.

Related Articles:Related Articles:

Chat Rating ReportChat Rating Report
Visitor Chat TranscriptVisitor Chat Transcript
TTimesheetsimesheets

https://www.youtube.com/watch?v=9-fdJC8ociE
https://chathelp.proprofs.com/chat-rating-report
https://chathelp.proprofs.com/visitor-chat-transcript
https://chathelp.proprofs.com/operator-performance-reports
https://chathelp.proprofs.com/timesheets
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Advanced
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How to route chat to another operator?
Chat Routing allows you to specify how incoming chat requests are routed (directed) to the available chat
operators. Typically, chats can be routed to the available operators automatically, or they can enter a queue
from which an operator can pick them up.
Here's how to enable Chat routing:
Step 1: Click "Operators" from the menu bar.

 
Step 2: Select "Yes" for chat routing, Click "Save."

 
Step 3: Set up the chat routing order for your operators, click and hold the icon, then drag and drop the
operators to their respective order. You can also the Chat Limit for operators through the drop down option.

 
Step 4: The below image depicts the use case, when an operator goes offline the next operator in the routing
order gets a pop-up message seeking confirmation to take the chat further. Selecting "Yes" would transfer the
chat to the operator, while selecting "No" would route the chat to the next operator.

https://www.proprofs.com/chat/chat-routing/
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Two rules can be set up for routing incoming chats:

Broadcast: With this setting, all chat operators get notified of all incoming chats. An1.
operator will then need to accept the chat request to start chatting. This is the default
setting.
Automatic assignment: With this setting, chats are evenly assigned among the2.
available operators in a pre-assigned order.

 
Chat Request will go to the operator who is the least busy, then will rout automatically in its
operator routing order. Every Operator will receive sound notification in its routing order, and
chat request will be visible to all online operators.
 
 
There are certain scenarios where we have to look at how our routing feature behaves
extensively.
 
Scenario 1: In case department is disabled.
 
Every online operator will receive sound notification in its routing order. Assuming there are four
Support operators:
 
Operator A, Operator B, Operator C, Operator D
 
If we define this routing order in the control panel (A→B→C→D), this is how the chat routing will take
place.
 
Case- 1: If all operators are free, chat request will go in the order that you have defined in the
control panel.

https://chathelp.proprofs.com/departments
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(A→B→C→D)
Case- 2: If all operators have some number of chats. Suppose:

Operator A is handing 5 customers

Operator B is handing 3 customers

Operator C is handing 7 customers

Operator D is handing 4 customers

 
In this case, B has a minimum number of chats so chat request will start from B and routing will
move in the order that you have defined in the control panel.
(B→C→D→A)
Case-3: If all operators have the same chat numbers.

Operator A is handling 4 customers

Operator B is handling 4 customers

Operator C is handling 4 customers

Operator D is handling 4 customers

 
In this case, the chat routing will go as per:
 

(A→B→C→D)
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Case-4: If some Operators are Offline.

Operator A is handling 4 customers

Operator B is handling 5 customers

Operator C is Offline

Operator D is handling 2 customers

Offline Operators will be skipped from routing order. Chat request will start from D because C is
Offline and in this situation D has the minimum number of chat.
 

(D→A→B)
In case department is enabled.
Every online Operator of that department will receive sound notification in its routing order.
Operator A, Operator B, Operator C, Operator D
Assuming that we have three departments - Accounts, Sales and Support and we have four
operators (A, B, C, D)
 
Operators & Departments settings are shown below :
Operators & Departments settings are shown below:
Account = A, B, C
Sales = A, B, D
Support = A, D, C
If routing order in control panel is: (A→B→C→D)
The following options will take place.
Case-1: If all operators are free, chat request will go department wise. If a visitor generates a
chat with Accounts department.
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(A→B→C)
In this case, D will be skipped because the Accounts department is not assigned to operator D.
The chat request will start from A because we have defined this routing order in control panel.
 
 
Case-2: If the following chatting order is taking place.

Operator A is handling 5 customers

Operator B is handling 3 customers

Operator C is handling 7 customers

Operator D is handling 4 customers

Now the visitor has generated a chat request from Accounts department.

(B→C→A)
In this case, D will be skipped because the Account department is not assigned to operator D
and chat request will start from B since B has the minimum chats.
 
Case-3: If all the operators have the same chat numbers.
The Visitor has generated a chat with Accounts department.

Operator A is handling 4 customers

Operator B is handling 4 customers

Operator C is handling 4 customers
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Operator D is handling 4 customers

In this case, a simple routing order will take place, which you have defined in the control panel.
Operator D will be skipped because of another department.
 

(A→B→C)
Case-4: If one operator is Offline, he/she will be skipped from routing order.
Now a visitor has generated a chat with Accounts department.

Operator A is handling 5 customers

Operator B is Offline

Operator C is handling 2 customers

Operator D is handling 8 customers

In this case, chat request will start from C because B is Offline and in this situation C has a
minimum number of chats. D operator will be skipped because of another department.

(C→A)
Case-5: If one Operator is offline, then which particular operator will be skipped from routing
order:
Now the visitor has generated a chat with the Sales department.
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Operator A is handling 5 customers

Operator B is Offline

Operator C is handling 1 customer

Operator D is handling 2 customers

In that case, chat request will start from D because B is offline and in that situation D has a
minimum number of chat requests. C operator will be skipped because of another department.

(D→A)
Case 6: If multiple operators are offline then those operators will be skipped from routing order.
Now a visitor has generated a chat request from the Sales department.

Operator A is handling 5 customers

Operator B is Offline

Operator C is handling 1 customer

Operator D is Offline

In this case, chat request will only go to A because D and B are offline and C belongs to the
other department.

Related Articles:Related Articles:

How Can Operators Enable Automatic Chat Acceptance?How Can Operators Enable Automatic Chat Acceptance?

https://chathelp.proprofs.com/how-can-operators-enable-automatic-chat-acceptance
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How Can I Set a Chat Limit for Incoming Chat to an Operator?How Can I Set a Chat Limit for Incoming Chat to an Operator?
How to Use Multiple Chat Windows on Your Website Using Single ProProfs Account?How to Use Multiple Chat Windows on Your Website Using Single ProProfs Account?

https://chathelp.proprofs.com/how-can-i-set-a-chat-limit-for-incoming-chats-to-an-operator
https://chathelp.proprofs.com/how-to-use-multiple-chat-windows-on-your-website-using-single-live2support-account
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How do Tickets Help Improve Customer Support?
ProProfs Chat allows you to support your customers even when operators are offline. Customers can raise
support requests as tickets so their issues are recorded and can be resolved at the earliest.
A ticket is a request from the end user that defines issues and concerns they might be facing with the product
or service. Support tickets are the most common form of problem resolution, especially in the absence of live
chat support. 
A user can submit a ticket through the offline message form when live chat support is not available.
Another scenario where users submit a ticket is when their chat request is not accepted by any operator.
User's chat request is kept on hold for the maximum wait time after which they can leave a message in form
of a support ticket through the offline message form.  

How to resolve Tickets:
Step 1: Log in to your ProProfs chat account and navigate to the "Tickets" tab.

Step 2: On the tickets tab you can view the unresolved tickets as "open," the resolved tickets as "closed" and
the responses sent to the users under the "sent" option.
Hover the cursor over the status option to view appropriate actions, you can select the checkboxes to apply
an action to multiple tickets in one go. To manually resolve a ticket click on the ticket to open it.

https://chathelp.proprofs.com/customise-offline-message
https://chathelp.proprofs.com/how-can-i-set-up-the-maximum-wait-time
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Step 3:  Frame an appropriate response to the user, or you can forward the ticket to another member of your
team. Once resolved, you can close the ticket by clicking the drop-down action menu above.  
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Resolve Tickets & Improve Revenue with Live Chat

Video About:  How to 10x Your Revenue using Sales Chat Software

 

https://www.youtube.com/watch?v=xPPPGWLKRmQ
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How do I use Tags?
You can add tags to streamline your tickets and transcripts. Using tags, you can easily categorize and
prioritize tickets and transcripts so that you can fetch them with one click.
Tags are words or combinations of words, you can use to add more context to tickets and transcripts. Tags in
Live Chat are like labels for records, they offer you an easy way to fetch a particular bunch of tickets and
transcripts and work on them.
For example, you can tag specific tickets as "Bugs" or "Error" and so on, for transcripts you might want to tag
all sales inquiries with a tag like 'sales' or 'about_sales.' 
Tags also offer a statistical advantage, for example, you can go in and know that 40% of your tickets are
related to one particular feature, and of that 20% were bugs and the remaining were questions. And of those
questions, 75% could be covered in docs. It takes some setup, but it’s super valuable to have that data and
then watch the numbers shift.

This article describes the following processes:

How to add tags to a ticket

How to add tags to a chat transcript 

How to search or sort tickets/transcripts using tags

How to add tags to a ticket:
Open a ticket and click the "+ Add Tags" button. Type the tag text and hit 'Enter' to save.
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How to add tags to a chat transcript:
Step 1: From the menu bar, click the "Transcripts" tab.

Step 2: Tags can only be added individually to a transcript. Click the "view"  icon for the transcript you wish to
add a tag to. 

Step 3: Click the "Add Tag" button to add a tag to the transcript.

To add tags to a live chat read "Operator Chat Window."

https://chathelp.proprofs.com/operator-s-chat-window
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How to search or sort tickets/transcripts using tags:
Tickets- Navigate to the 'tickets' tab and sort tickets by clicking the desired tag. Refer to the screenshot
below: Here we have sorted all the tickets which marked by the tag "Sales."

Transcripts- Navigate to the transcripts tab and sort visitor transcripts by clicking the desired tag. Refer to the
screenshot below: Here we have sorted transcripts which are marked by the "Sales" tag.

 

Related Articles:Related Articles:

Chat RoutingChat Routing
Jumping Chat IconsJumping Chat Icons
How Can I Set a Chat Limit for Incoming Chat to an Operator?How Can I Set a Chat Limit for Incoming Chat to an Operator?

https://chathelp.proprofs.com/chat-routing
https://chathelp.proprofs.com/jumping/bouncing-icon
https://chathelp.proprofs.com/how-can-i-set-a-chat-limit-for-incoming-chats-to-an-operator
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Chat Greetings
Chat Greetings are proactive chat messages that let you welcome website visitors with custom
messages based on user behavior.
A more personalized, and targeted chat invitation is the perfect way to start off a conversation
and engage your website visitors. 
For example: Greet people who have spent at least 10 sec on your pricing page with "Do you
have any questions about our pricing?" Greet people who are on your 'about' page with "Do you
have any questions about our company?"
Here's a preview of how it will appear on your website:

Follow these steps to enable greetings for your visitors:
Step 1: Log into your chat account and click "Settings," then click "Greetings" from the vertical
menu.

https://www.proprofs.com/chat/chat-greeting/
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Step 2: To customize default greetings click the 'expand tab' or click "Create Greeting" to add a
new greeting.   

Step 3: Switch the toggle button to "ON," enter a title for greeting in the text box, like "Spent 10
seconds on a page." Set up the conditions which should be met for this greeting to pop up.
Enter the message in the 'greeting' text box, or you can use the default greeting. Click "Save" to
enable chat greeting.
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You can create unlimited greetings to cater your customer/visitor support better, set up
greetings by setting up specific conditions for a more personalized and targeted chat invitation.
In a way, every page on your website can have a personalized greeting to engage the visitors
and turn them into customers. 
The conditions include:

Chat status: You can enable greeting for when chat is online, offline or for both online and
offline chat. 

Set up greeting for 'time spent on current page,' a specific 'URL,' or for a returning visitor. 

On setting up the conditions, you can either choose to greet with a message or to expand the
chat box. Chat Box expansion indirectly invites the visitor to seek help through live chat. 

Frequency: Setting the frequency to "Single" will allow greeting to appear once in a session
while setting it to "Multiple" will allow greeting to appear every time the page is reloaded or
visited. 

Enable Sound Notification: Navigate to "Settings"-----> "General"-----> "Sound," and enable sound
for 'Greetings' and click "Save" to implement the changes. 
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Take a Complete Tour of ProProfs Chat

Video About:  Tour of the Best Live Chat Software

Related Articles:Related Articles:

Chat RoutingChat Routing
Tickets and TagsTickets and Tags
Co-browsing With ProProfs ChatCo-browsing With ProProfs Chat

https://www.youtube.com/watch?v=NVIjlCvOwuc
https://chathelp.proprofs.com/chat-routing
https://chathelp.proprofs.com/tickets-and-tags
https://chathelp.proprofs.com/co-browsing
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Co-browsing
Co-browsing is the advance feature of ProProfs Chat, which has fully customized web page
viewing capability that enables live chat support operators to remotely access the web page of
your website on which site visitors visited during a chat session resulting in higher levels of
customer satisfaction.
ProProfs Chat provides a dynamic co-browsing option for chat operators. In the specific context
of live chat software, co-browsing permits support operators to view the web page of your
website on which site visitors visited during a chat session. This feature is activated by clicking
the appropriate icon in ProProfs operator chat window. Co-browsing enables chat operators to
directly access the page being visited on website by site visitors. The moment a site visitor
clicks a new page, the screen view available to the chat operator attending to the site visitor
changes instantly. Chat operators can not only direct customers to specific web pages on the
website and view these pages simultaneously, but also explain them to customers in real time
through live chat.
Working of Co-browsing
When a chat session is going on, the operator can click on Co-browsing button available in
operator chat window to see the visitor’s page which opens in a new window. The page will
change at the operator end as the visitor clicks on another page.

Relevance of Co-browsing during Chat Session
With Co-browsing, Chat operators can not only direct customers to specific web pages on the
website and view these pages simultaneously, but also explain them to customers in real time
through live chat. This feature can go a long way in making it possible for chat operators to
further explain specific products and services displayed on their websites. It also comes as a

https://www.proprofs.com/chat/co-browsing/
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valuable asset to analyze technical diagrams, schematics and other graphical representations
of specific products presented on the company’s website.

Provide Support Anytime, Anywhere

Video About:  How to Enable Anytime, Anywhere Customer Support

 

Related Articles:Related Articles:

Chat RoutingChat Routing
Tickets and TagsTickets and Tags
Chat GreetingsChat Greetings

https://www.youtube.com/watch?v=VzycUl-IXZk
https://chathelp.proprofs.com/chat-routing
https://chathelp.proprofs.com/tickets-and-tags
https://chathelp.proprofs.com/chat-greetings


Live 2 support help
ProProfs Chat FAQs Advanced

Copyright © 2014 ProProfs Page 114

Live Chat Icons
Customize chat icons to grab a visitor's attention instantly. You can place the icons anywhere
on your website and customize them to match the layout of your web pages.
ProProfs Live Chat enables you to customize:

Chat Icons

Multiple Chat Icons

Jumping Chat Icons

Chat Icons

A chat icon is the first step to engage your website visitors, you can customize them to grab
their attention instantly. Here's how to customize chat icons in ProProfs Live Chat: 
Step 1: Navigate to "Settings" -----> "General" -----> "Buttons & Icons." Under the 'Chat Icons' tab
click the 'edit' buttons to customize online and offline chat icons. 

You can also select to hide the chat icons when operators are offline.You can also select to hide the chat icons when operators are offline.

Step 2: Select an appropriate icon from the image library or upload one from your local drive.
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Click "Done" to save the changes.

Multiple Chat Icons

You can place multiple "live help" icon/text on different locations of your web page. 
Here's how you can place multiple icons on a web page:
Step 1: Customize the location and appearance of your second or third icon.

Step 2: Click to view the 'additional code,' copy the code and paste it before </body> tag in the
webpage you want the additional icon to appear.
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Jumping/Bouncing Chat Icons

With ProProfs Chat, you can place jumping/bouncing icons on any of your web pages. This
helps you to draw the attention of visitors to initiate a chat. 
Here's how you can place jumping icons on your web page:
Step 1:  Select the positioning, size, floating speed and other specifications. You can
also upload icon images for offline and online mode.
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Step 4: Click to view the 'additional code,' copy the code and paste it before </body> tag in the webpage you
want the jumping icon to appear.



Live 2 support help
ProProfs Chat FAQs Advanced

Copyright © 2014 ProProfs Page 118

More Live Chat Customization Options

Video About:  How to Customize Your Live Chat Window

Related Articles:Related Articles:

Chat RoutingChat Routing
Tickets and TagsTickets and Tags
Multiple IconsMultiple Icons

https://www.youtube.com/watch?v=eanb9XWa_KQ
https://chathelp.proprofs.com/chat-routing
https://chathelp.proprofs.com/tickets-and-tags
https://chathelp.proprofs.com/multiple-icons
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Customization of Style Sheet
Customization of style sheet allows you to customize the visitor interface according to the look
and feel of your website. You can customize the color of the visitor interface window, text font,
font size, text color, etc.
Find below the detailed explanation of Style Sheet.
Section: 1- Under this section, you can define your text size and text style of the window by edit
in style sheet below.. Please note all changes will be made at visitor interface.

Section: 2- Under this section, you can define your text fields border according to your need.
Please note all changes will be made at visitor interface.
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Section: 3- Under this section, you can define your chat announce color and font. Please note
that all changes will be made at visitor interface.

Section: 4- Under this section, you can decorate text used in the presentation of hyperlink
option. You can define your message timing color font. Please note all changes will be made at
visitor interface.
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Section: 5- Under this section, you can change the background color of Send & Logout/Close button. You can
also change the text style, size, the width of the border and border color of the buttons. Please note all
changes will be made at visitor interface.

Section: 6- Under this section, you can change the background color of other buttons except for
send & logout (like email, continue, etc.). You can also define focus on the fields, and width of
the border and border color of the buttons. Please note all changes will be made at visitor
interface.
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More Live Chat Customization Options

Video About:  How to Customize Your Live Chat Window

Related Articles:Related Articles:

Chat RoutingChat Routing
Tickets and TagsTickets and Tags
Advanced TrackingAdvanced Tracking

https://www.youtube.com/watch?v=eanb9XWa_KQ
https://chathelp.proprofs.com/chat-routing
https://chathelp.proprofs.com/tickets-and-tags
https://chathelp.proprofs.com/advanced-tracking
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How to use multiple chat windows on your website
using single ProProfs Chat account
You can use different chat windows on different pages of your website and a unique window for
a specific department which can be customized as per department need. You can change
language, font, text, fields & header images of the chat window as per your requirement.
Similarly, you can use different chat invitations for different pages of your website. You can
customize it by logging into the ProProfs Chat Control Panel.
Find below the possible scenario, where you can use these settings:
Use this feature without making department.
Add the languages as per your requirement.
Visitors Window Customization→ Edit Chat Window Messages.
Click on Add new language button at the bottom of the web page to add a new language.

There are two different cases →
Case 1- If you want to customize all the chat windows in one particular language, create all



Live 2 support help
ProProfs Chat FAQs Advanced

Copyright © 2014 ProProfs Page 124

language profiles in the same language.
Eg- If you want to create three different windows in English, create three language profiles in
English (English A, English B, English C) and customize them.
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Case 2- If you want to use different chat windows in different languages, create different
profiles in different languages.
Eg- If you want three chat windows (English, Spanish, and Portuguese), create three language
profiles respectively.
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Now you can easily use different chat window on different
pages.

If you want to use different header images, follow the below mentioned steps.
Visitors Window Customization→ Edit Chat Window Messages →Change Character Set & Header
Image URL.

(Select the image and click on Save Changes)
If you want to use different invitation, follow the below mentioned steps.
Visitors Window Customization→ Edit Chat Window Messages →Manage Pro-Active/Auto Chat
Invitation.
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(Make changes as per your website look and feel and click on Save Changes)
If you want to use different Pre chat form, follow the below mentioned steps.
Visitors Window Customization→ Edit Chat Window Messages →Manage Customized Pre chat
Form.
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(Make changes as per your website look and feel and click on Save Changes)
If you want to use different Post chat form, follow the below mentioned steps.
Visitors Window Customization→ Edit Chat Window Messages →Manage Customized Survey
Form.
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(Make changes as per your website look and feel and click on Save Changes)
If you want to use different offline message form, follow the below mentioned steps.
Visitors Window Customization→ Edit Chat Window Messages →Manage Customized Leave
Message Form.
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(Make changes as per your website look and feel and click on Save Changes)
Once you have made the changes, go to
Codes & Graphics for Your Webpage > Get Codes to Insert in Your Webpages.
You would see three options on the top of the page. Select the second option Codes with
advance features option.
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You would get four options →
Select the language profile, you made changes on from Select Language.
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Click on Get Code option. Copy the codes and place them where you want to display the icon of
the particular language profile.

If you want this feature with department.
Add the languages and department as per your requirement.
Visit the below mentioned page to know how to add departments.
http://www.Live2Support.com/onlinehelp/add-edit_departments.htm

http://www.Live2Support.com/onlinehelp/add-edit_departments.htm
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Add languages as per your requirement.
Visitors Window Customization→ Edit Chat Window Messages.
For adding a new language clicks on Add new language button on the bottom of the web page.

Now you can easily use different chat windows on different
pages with department.

If you want to use different header images, follow these steps.
Visitors Window Customization→ Edit Chat Window Messages →Change Character Set & Header
Image URL.
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(Select the image and click on save changes)
If you want to use different invitation, follow these steps.
Visitors Window Customization→ Edit Chat Window Messages →Manage Pro-Active/Auto Chat
Invitation.
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(Make changes as per your website look and feel and click on save changes)
If you want to use different Pre chat form, follow these steps.
Visitors Window Customization→ Edit Chat Window Messages →Manage Customized Pre chat
Form.
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(Make changes as per your website look and feel and click on save changes)
If you want to use different Post chat form, follow these steps.
Visitors Window Customization→ Edit Chat Window Messages →Manage Customized Survey
Form.
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(Make changes as per your website look and feel and click on save changes)
If you want to use different offline message form, follow these steps.
Visitors Window Customization→ Edit Chat Window Messages →Manage Customized Leave
Message Form.
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(Make changes as per your website look and feel and click on “save changes”)
After making changes go to
Codes & Graphics for Your Webpage→ Get Codes to Insert in Your Webpages.
You would see three options on the top of the page. Select the second option Codes with
advance features option.
You would get four options →
Select the department you want to display on the particular window.
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Select the language profile you edited from Select Language.
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Click on Get Code option. Copy the codes and place them wherever you want to show the icon
of the particular language profile.

Repeat the process to add other languages.



Live 2 support help
ProProfs Chat FAQs Advanced

Copyright © 2014 ProProfs Page 142

More Live Chat Customization Options
Video About:  How to Customize Your Live Chat Window

Related Articles:Related Articles:

Block IP AddressBlock IP Address
How Can Operators Enable Automatic Chat Acceptance?How Can Operators Enable Automatic Chat Acceptance?
How Can I Set a Chat Limit for Incoming Chat to an Operator?How Can I Set a Chat Limit for Incoming Chat to an Operator?

https://www.youtube.com/watch?v=eanb9XWa_KQ
https://chathelp.proprofs.com/block-ip-address
https://chathelp.proprofs.com/how-can-operators-enable-automatic-chat-acceptance
https://chathelp.proprofs.com/how-can-i-set-a-chat-limit-for-incoming-chats-to-an-operator
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Block IP Address
This feature allows you to block the visitors who are not genuine.
Blocking the IP address would disable the chat icon on your website for the visitors coming from the Blocked
IP Address.
To Block IPs:
Step 1 Log in to your Control Panel.
Step 2:  Click on Settings in the top right corner of your screen

Step 3:  On the Settings page, click on Preferences
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Step 4:  After clicking on Preferences, click on Block IP Address
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Step 5: Enter the IP Address in the given text box

Step 6:  Click Block to add the IP address in the blocking list

You have successfully added the IP address to your blocking list . 
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Note* To unblock any IP address, highlight the IP address, tick Blocked IP in the mini checkbox, and then an
Unblock icon will appear. Click Unblock to unblock all selected IP addresses that were unblocked earlier.

Related Articles:Related Articles:

Chat RoutingChat Routing
Tickets and TagsTickets and Tags
Chat GreetingsChat Greetings

https://chathelp.proprofs.com/chat-routing
https://chathelp.proprofs.com/tickets-and-tags
https://chathelp.proprofs.com/chat-greetings
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Manage Ad Campaigns
The visitors coming through ad campaign are the paid visitors, so the main goal of support operator is to
convert those site visitors into customers.
With this feature, you can determine:

Which advertising source is beneficial for you.

Which source is providing maximum visitors. 

Where you should invest your advertising budget & where you should decrease your budget. 

what kind of strategies you should opt to increase your advertisement & promotion.

In this feature, you can set a specific color for each source, so that in visitor monitoring window, you can
determine which source is fetching you visitors. Then you can set your advertising budget accordingly.

How to Add Ad Campaign in your Live Support
Add/Edit Ad Campaign allows you to Add/Edit campaigns for your website. This feature helps you to add and
save campaigns for future use. Once created, Campaigns can be edited at any time through Add/Edit Ad
Campaign option from Customization and Preferences options.
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To set up a list of Campaigns:

Login to ProProfs Chat Control Panel.

Click on Add/Edit Ad Campaign under Preference and Setting. This takes you to the Add/Edit Ad
Campaign page which displays a list of campaigns that you have already set. You can add a new
campaign by clicking on the Add/Edit Ad Campaign link at the top right side of the page.

Add New Campaign
This takes you to the Add Campaign page.

Code: Paste code for new ad campaign.

Define Color: Assign a color to a particular campaign so that visitor’s IP from that campaign can be
displayed in that color in visitor monitoring window.

Brief Description: Describe new ad campaign.

Click Add Campaign to save ad campaign.

Click Reset to reset all fields and start over again.
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You can edit previously set Predefined Ad Campaigns from Add/Edit Advertisement Campaigns page.
Add/Edit Advertisement Campaign page displays a list of predefined campaigns with links to Edit, Delete or
get the code for that campaign.
Edit: This link opens the campaign for editing. You can modify any of the information in Ad Campaign using
this option.

Delete: Delete Ad Campaign and remove it from the list of campaigns.
Get Code: Facilitates getting code for ad campaign from an external source.

To get the codes for external use, click on get codes. A window will pop-up where you need to give URL of
website for which you have started campaigning and click on the continue button after which you will get
codes for external use, which you can paste in the page where you want to display an ad of your website. This
code will be pasted where you will paste the URL address of a landing page. This will count the number of
visitors that are coming from that ad campaign.
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This is the URL that you need to place on your landing page along with the advertisement.

Related Articles:Related Articles:

Chat RoutingChat Routing
Tickets and TagsTickets and Tags
Chat GreetingsChat Greetings

https://chathelp.proprofs.com/chat-routing
https://chathelp.proprofs.com/tickets-and-tags
https://chathelp.proprofs.com/chat-greetings
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Advanced Tracking
Advanced tracking in enables you to pass custom information as variables from your web
pages to ProProfs Chat.
You can pass custom id, order information related to the customer or any other information
available in your database to ProProfs.

Advanced Tracking

Invisible Tracking

ProProfs provides an option for passing custom information variable from your web pages to
ProProfs. You can pass custom identification information, order information related to this
customer or any other information you want to pass from your web page to ProProfs. This
information will be available to you in visitor monitoring window and in the support operator
chat  window.  Using this  feature many customer specific  information can be immediately
available to support operator as soon as he or she picks chat.

For example, you can pass customer name, order no. and city

In 1st box in "add custom variables & values" window you can type "customer name" and in
second  box  you  can  type  the  name  of  customer  or  the  name  of  variable  (if  you  are
using PHP <?=$sVariable; ?> or if you are using ASP <%=$ sVariable %>, same way for any other
language your are using in your web page) you will be using in your web pages to substitute 
value. This way you can pass any number of variable information.

Once you added all require variable then click on "Done" and "Add Custom Variables &1.
Values" window will close.

Copy all code, and paste them in your web pages just above the ProProfs codes.2.

The following is the sample of additional codes which you need to place just before the
ProProfs tracking codes :

<script type="text/javascript">
var l2s_cv='cname=<?=$custname;?>;l2scv;caddress=<?=$custadd;?>;l2scv;ccity=<?=$city;?>
</script>

Custom information will be available to support operators in visitor monitoring window as well
as chat window. It helps the support operator to know the visitor’s specific information as soon
as a chat is accepted. See the images below:
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For example, you can pass customer name, order no. and city.

In "Add a Custom Variables & Values" window, you can type the customer name and in the
second box you can type the name of customer or the name of variable.

If you are using PHP then the variable would be: <?=$sVariable; ?> or if you are using ASP
then <%=$ sVariable %>

This way you can pass any number of variable information. After adding all the variables
click on "Done" and "Add a Custom Variables & Values" window will be close.

The following codes would be visible in your ProProfs Chat codes additionally:

      var
l2s_cv='cname=<?=$custname;?>;l2scv;caddress=<?=$custadd;?>;l2scv;ccity=<?=$city;?>';

In this case, your web page must substitute information correctly for your own scripting
variables: $custname, $custadd, $city. Click on Get Code button now, copy all code, and
paste them in your web pages.

Invisible Tracking

For Invisible Tracking, just copy and paste the code on the page of your website before </body>
tag. 
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Take a Complete Tour of ProProfs Chat

Video About:  Tour of the Best Live Chat Software

Related Articles:Related Articles:

Chat RoutingChat Routing
Tickets and TagsTickets and Tags
Multiple IconsMultiple Icons

https://www.youtube.com/watch?v=NVIjlCvOwuc
https://chathelp.proprofs.com/chat-routing
https://chathelp.proprofs.com/tickets-and-tags
https://chathelp.proprofs.com/multiple-icons
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How do I set a chat limit for incoming chats to an
operator?
The Chat Limit feature is only applicable for operators when Autochat is enabled. Admins can set up
limitations for the system to automatically accept incoming chats for operators. For example, if an admin
sets an operator's chat limit to 10, then the system will automatically accept 10 incoming chats for the
operator. 
Here's how you can set operator chat limit:
Navigate to "Operators" from the admin dashboard. Select 'chat limit' for operators through the drop-down
menu. 

What happens when incoming chats exceed the limit?
The system does not automatically assign more chats to an operator already handling the maximum number
of chats. The incoming chats appear in the operator's dashboard with an option to "Accept" the request (refer
to screenshot below). The chat request will continue until the user cancels the request or an operator accepts
the request.
If "Maximum Wait Time" is enabled then the user's request will be active for the time duration set in
"maximum wait time." 
After an incoming chat request has waited for "maximum wait time" to be connected to an operator, the
system assumes all operators are busy. The user requesting chat is then shown a form ( offline message
form) so they can leave a message.

 

https://chathelp.proprofs.com/how-can-operators-enable-automatic-chat-acceptance
https://chathelp.proprofs.com/how-can-i-set-up-the-maximum-wait-time
https://chathelp.proprofs.com/customise-offline-message
https://chathelp.proprofs.com/customise-offline-message
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Related Articles:Related Articles:

Customization of Style SheetCustomization of Style Sheet
How Can Operators Enable Automatic Chat Acceptance?How Can Operators Enable Automatic Chat Acceptance?
How to Use Multiple Chat Windows on Your Website Using Single ProProfs Account?How to Use Multiple Chat Windows on Your Website Using Single ProProfs Account?

https://chathelp.proprofs.com/customization-of-style-sheet
https://chathelp.proprofs.com/how-can-operators-enable-automatic-chat-acceptance
https://chathelp.proprofs.com/how-to-use-multiple-chat-windows-on-your-website-using-single-live2support-account
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How do operators enable automatic chat
acceptance?
ProProfs Live Chat allows automatic chat acceptance for operators through the Autochat
feature. When Autochat is enabled for a particular operator, the system will automatically
accept incoming chats for the operator. Incoming chats which will be automatically accepted
depends upon the operator's chat limit.
Here's how operators can enable "Autochat" through their dashboard:
Log in to your operator dashboard/visitor monitoring window, enable "Autochat" from your
profile options.

Provide Support Anytime, Anywhere

Video About:  How to Enable Anytime, Anywhere Customer Support

Related Articles:Related Articles:

Advanced TrackingAdvanced Tracking
How Can I Set a Chat Limit for Incoming Chat to an Operator?How Can I Set a Chat Limit for Incoming Chat to an Operator?
How to Use Multiple Chat Windows on Your Website Using Single ProProfs Account?How to Use Multiple Chat Windows on Your Website Using Single ProProfs Account?

https://chathelp.proprofs.com/operator-chat-limit
https://www.youtube.com/watch?v=VzycUl-IXZk
https://chathelp.proprofs.com/advanced-tracking
https://chathelp.proprofs.com/how-can-i-set-a-chat-limit-for-incoming-chats-to-an-operator
https://chathelp.proprofs.com/how-to-use-multiple-chat-windows-on-your-website-using-single-live2support-account
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Visitor Chat Transcript
The entire conversation which happens between the website visitors/customers and chat operators is
contained inside the visitor chat transcript.
This allows you to keep an archive of all your chats on file and can be used by your chat operators for training
and evaluation purposes. 
To access your visitor chat transcripts:
Step1. Log in to Chat Dashboard.
Step2. Click on "Visitor Chat" under "Transcripts." Click "Advanced."

Note* In the "Advanced" tab, you can select any operator from the operator's drop down. This allows you to
see the transcripts for the selected operator with additional information like visitor's name, date, and duration
of the chat.
Step3. To get operator specific chat transcript, select an operator from the drop-down, select the "Date range"
and "Search criteria." Then, click on "Search."
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Step4. Once you click on "Search," a list of chat transcripts of the selected operator will appear. You can click
on the magnifying glass icon under the "View" column to see any chat transcript. (refer to the screenshot
below)

Downloading chat transcripts:
Step1. To download chat transcripts, click on the "Download" icon above the "View" column. (see image
below)
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Step2. Once you click on "Download" icon, you will be taken to the archive of chat transcripts. Here you can
select the "Date range" and download transcripts of any period. (see image below)

Related Articles:Related Articles:

Chat Rating ReportChat Rating Report
Visitor ReportsVisitor Reports
Operator Performance ReportsOperator Performance Reports

https://chathelp.proprofs.com/chat-rating-report
https://chathelp.proprofs.com/visitor-reports
https://chathelp.proprofs.com/operator-performance-reports
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APIs



Live 2 support help
ProProfs Chat FAQs APIs

Copyright © 2014 ProProfs Page 161

PreChat Form API
ProProfs Live Chat Software allows you to collect user information and also validate their
details before initiating a chat through the PreChat Form feature. PreChat Form API provides for
direct 3rd party API integration of ProProfs Chat with your server/database. With PreChat Form
API, you can validate user details before initiating the chat and simultaneously transfer the user
details to your own server for future use. Once successfully validated, you can initiate your chat
with the visitor.
Following variables will be posted to your script using a standard form after PreChat Form API
is enabled:
l2s_id - Site ID,
l2s_sessid - Visitor session ID,
l2s_ip - Visitor IP address,
l2s_name - Visitor name,
l2s_email - Visitor email,
& All custom variables passed from webpages (If any)
Following variables will be posted to your script using customizes form.
l2s_id - Site ID,
l2s_sessid - Session ID,
l2s_ip - IP address,
l2s_name - Visitor name,
l2s_email - Visitor email,

& All custom variables
 
All fields in customized form(like fld_1, fld_2, fld_3 ... fld_n)

How to enable PreChatForm API

The following steps will show how PreChat Form API can be activated in ProProfs Live Chat.
Step 1: Go to Settings---->Advanced---->API.

https://chathelp.proprofs.com/visitor-chat-window-settings$Prechat%20form
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Step 2: Enable Pre Chat User Authentication. Enter the name of the website in Host and the
server link in the Script Path. Click on Check Connection. If the connection is successful, click
on Save.
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Chat Transcripts API 
After chat session, there are options available to set up an email address for automatically sending the chat
transcript. 
You can allow the system to post chat transcript automatically after each chat session to your application or
3rd party application. Simply specify the URL and other details. After each chat session, the transcript will be
posted to the specified URL, which you can add to your customer log etc.
Post transcript after chat session
l2s_id - Site ID,
l2s_sesid - Session ID,
l2s_ip - IP Address,
l2s_name - Visitor name,
l2s_email - Visitor email,
l2s_question- Question(Custom form)
l2s_logid - Operator ID
l2s_msg - Chat transcript text
l2s_date - Date of chat
& All custom variables passed from web page.
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Send offline messages to a helpdesk/ticketing
software via API 
If you use standard or custom off-line message form option on submission of off-line message an email will
be sent to the specified email id, and data will also be posted to URL you specify along with other information.
Offline messages (Leave a message)

Following variables will be posted via the script path. 
l2s_sesid- Session ID
l2s_sid - Account ID
l2s_ip - IP Address
l2s_name - Name
l2s_email - Email address
l2s_msg - Message
l2s_date - Date
In case of a customized offline message from:
l2sesid- Session ID
l2sid - Account ID
l2ip - IP address
and number of fields created will be accessible in the form of fld_1, fld_2, fld_3.....fld_n
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GDPR
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ProProfs' Commitment to GDPR
Here, at ProProfs we are committed to protecting your data and respecting your privacy. The General Data
Protection Regulation (GDPR), a new regulation, is a set of security principles and protocols laid by the
European Union to protect the data interests of European Citizens. The regulation is in effect from May 25th,
2018.  Learn More 

What is GDPR?
The General Data Protection Regulation (GDPR) aims to ensure that corporations inside or outside the
European Union become more transparent about how they collect, handle and process personal data of
European Citizens. The primary goal of GDPR compliance is to eliminate security gaps when it comes to
collecting data from the users and allow total data control back to the users. The GDPR laws vary depending
upon your location and the role you play in respect to the EU citizens. Find out more specific information on
GDPR on Wikipedia.
With GDPR in effect, most organizations that collect, maintain, or process EU residents’ personal data
(regardless of the organization’s global location) are required to implement specific procedures and
safeguards for that data. We at ProProfs have made GDPR compliance a priority and are working to ensure
we reach the required levels of transparency and compliance. 

Where can I read ProProfs' privacy policy?
ProProfs shares the GDPR’s commitment to transparency, fairness, and accountability which is why
we have updated our Privacy Policy and Terms of Service. Please check them out and email us
at privacy@proprofs.com if you have any questions!

How do I add cookie consent to my website?
Cookie Consent is a part of privacy legislation that requires websites to get consent from visitors to store or
retrieve any information on your device. If GDPR requires you to add a cookie consent to your website you can
use free solutions like 'Cookie Consent by Insites' to add cookie consent to your website. 

https://www.proprofs.com/gdpr/
https://en.wikipedia.org/wiki/General_Data_Protection_Regulation
https://www.proprofs.com/policies/privacy/
https://www.proprofs.com/policies/terms/
mailto:privacy@proprofs.com
https://cookieconsent.insites.com/
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How does ProProfs Live Chat support data
portability?
With GDPR in effect from 25th May 2018, every user has the right to access their data. Administrators can
access their end-users data and help serve their users' data rights. Learn more about GDPR and Data
Portability.
ProProfs Live Chat allows customers to download visitor chat transcripts and various reports. 
Here's how you can download the visitor chat transcripts:
Step 1: Navigate to "Transcripts" -----> "Visitor Chat Transcripts," click the 'download chat transcripts' button to
download all transcripts of your visitors.  Additionally, you can search for a particular transcript using the
search box, and then download the particular transcript. 

Step 2:
(i) To download all transcripts of a particular visitor, click "Advanced."

 
(ii) Generate a custom search, select "Visitor Name" as the search criteria, select 'All' for operators and
customize 'date range.' Click "Search." The search will fetch all transcripts of that visitor, click the 'download'
icon to export all transcripts. 

https://gdpr-info.eu/art-20-gdpr/
https://gdpr-info.eu/art-20-gdpr/
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To export various reports refer to the Reports section of the Chat Help site.

https://chathelp.proprofs.com/reports
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Integrations
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ProProfs
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Live Chat Integration with Knowledge Base 
Video About: How to Integrate Chat with Your Knowledge Base 

Reduce chat tickets & improve user experience with Knowledge Base accessibility through the
chat window. Users can opt for self-help and still connect to the operator if their question is
unanswered.
Here's how the chat will appear with Knowledge Base integration:

How to integrate Knowledge base with chat:
Step 1: Navigate to "Settings" -----> "General" -----> "Knowledge Base."

https://www.youtube.com/watch?v=e4duAZVFi-I
https://www.proprofs.com/chat/integrations/knowledgebase/
https://www.proprofs.com/chat/integrations/knowledgebase/
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Step 2:  Turn "On" the Knowledge Base integration. Set up the conditions. Enter the URL of
Knowledge Base and click "Select Article" to set up a minimum of 5 articles to show in the chat
window. 

Step 3: Select articles from the list and click "Add."
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Step 4: Click "Save" to secure and implement the changes.
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Google
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Google Analytics Integration with ProProfs Live
Chat
ProProfs Chat Google Analytics Integration enables you to record visitors’ live chat actions in your Google
Analytics account. The integration pushes the data to your Google Analytics account via the Analytics
JavaScript. 
You need to save your account id (e.g. UA-123456-1) in your dashboard and then follow these steps to see
statistics in your Google Analytics account.
If you want to track chat form, offline messages form and survey form statistics in Google Analytics, you need
to generate code for multiple domains from your Google analytics account or replace existing codes in your
web pages with the following codes after replacing your Google Analytics account Id (UA-xxxxxx-x).

<!-- Google Analytics →
<script>
(function(i,s,o,g,r,a,m){i['GoogleAnalyticsObject']=r;i[r]=i[r]||function(){
(i[r].q=i[r].q||[]).push(arguments)},i[r].l=1*new Date();a=s.createElement(o),
m=s.getElementsByTagName(o)[0];a.async=1;a.src=g;m.parentNode.insertBefore(a,m)
})(window,document,'script','//www.google-analytics.com/analytics.js','ga');
ga('create', 'UA-XXXX-Y', 'auto');  // Replace with your property ID.
ga('send', 'pageview');
</script>
<!-- End Google Analytics -->

To integrate ProProfs Chat with Google Analytics:
Step 1: Log in to ProProfs chat control panel with your valid credentials.
Step 2: Navigate to "Settings" -----> "Integration" -----> "Analytics,"  paste your Google Analytics account Id (UA-
xxxxxx-x). 

 

Make sure you have both the ProProfs Chat code and Google Analytics tracking code installed onMake sure you have both the ProProfs Chat code and Google Analytics tracking code installed on
your sites to log all the information coming from ProProfs Chat to your Google Analytics account.your sites to log all the information coming from ProProfs Chat to your Google Analytics account.

Here's how you can retrieve your Google Analytics account Id (UA-xxxxxx-x) and script:
(i) Navigate to "Admin" -----> "Tracking code."

https://www.proprofs.com/chat/integrations/google-analytics/
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(ii) Copy the Tracking code.

You can now set goals for different Chat window URLs given below, or you can see reports without
setting goals in your account under ‘Visitors’ -----> ‘Custom Variables’ for chats from separate chat
IPs.

 Add multiple goals with the following URLs:

For Online Chat window (URL:/ls3/chat.php )

For Offline Message(URL: /ls3/zvcmail.php)

For Survey Form (URL: /ls3/zvcp_sur.php)

Follow these steps to set goals:
(i) Navigate to "Admin" -----> "Goals," to set goals for ProProfs Chat in your Google Analytics account. 
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(ii) Create goals and click "Save" to secure the changes.

(iii) Here's how the goals will appear:

Default reports added in your Google Analytics account
To check out, the default report, navigate to “Reports”-----> “Audience” -----> “Custom” and select “Custom
Variables.”
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You will see the activities for every visitor from a particular IP address.

Once you create and save goals, you can see the record after 24-48 hours for Google Analytics toOnce you create and save goals, you can see the record after 24-48 hours for Google Analytics to
start tracking. This is the standard processing latency” time for all data in Google Analytics.start tracking. This is the standard processing latency” time for all data in Google Analytics.  
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 Integrating Blogger With ProProfs Live Chat
Adding Proprofs Live Chat to your Blogger helps you interact with your readers and also provide direct
answers to any queries they might have. It provides you with a more direct connection with your users.
Blogger integration can also help in sending canned responses to new readers and establish a line of
communication between you and them.
The following steps will show you how to integrate ProProfs Live Chat into your blog.
Here is how your blog will look after Live Chat Integration:

Integrating Blogger With ProProfs Live Chat
Step 1: Go to Settings -----> Installation
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Step 2: Copy the given code and open your Blogger account.

Step 3: In your Blogger account, Go to Themes -------> Edit HTML.



Live 2 support help
ProProfs Chat FAQs Google

Copyright © 2014 ProProfs Page 181

Step 4: Paste the code before '</body>' command and click on 'Save'.

Related Articles:                                                                                                                           Related Articles:                                                                                                                           
                                                                                                                                                                                                                                                                                                              
                                                                                                                                                Google Analytics Integration with ProProfsGoogle Analytics Integration with ProProfs
Live Chat Live Chat                                                                                                                                                                                             Add ProProfs LiveAdd ProProfs Live
Chat to Wordpress WebsiteChat to Wordpress Website                                                                                                                                                                                                              
      

https://chathelp.proprofs.com/integration-with-google-analytics
https://chathelp.proprofs.com/integration-with-google-analytics
https://chathelp.proprofs.com/live-chat-in-wordpress
https://chathelp.proprofs.com/live-chat-in-wordpress
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CRM
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Integrate Salesforce With ProProfs Live Chat
ProProfs and Salesforce share and transfer information to manage sales and support workflow.
It drives Salesforce performance and profitability by keeping the chat operator up to date on any
communication with the new or already existing visitor.
ProProfs Chat and Salesforce CRM integration enable the sales and support team to move the
relevant information collected during live chat sessions directly to the Salesforce CRM.
With this integration new leads, customer's information and contacts will be created
automatically as soon as you start a live chat from ProProfs.
Chat transcripts along with the other details collected via ProProfs Chat will be added to
Salesforce to support sales leads for future reference.

If a user visits the site multiple times and is part of multiple chats with operators, theIf a user visits the site multiple times and is part of multiple chats with operators, the
information will add as a lead in Salesforce every time the user takes part in a chatinformation will add as a lead in Salesforce every time the user takes part in a chat
session. session. 

ProProfs provides the following sales driving features:

Stored customers data can be pulled out at any time for any reference.

Updated information of customers brings familiarity.

Increase chat efficiency and support functions.

Enhance customer interaction.

Real-time traffic analysis.

Salesforce has two experiences; Classic view and lightning experience. So, in order to perform
this integration, you would need to switch your salesforce to classic view. Here's how you can
do it:
Step1. Login to your Salesforce account.
Step2. From your dashboard, click on "View Profile". (see screenshot below)

https://www.proprofs.com/chat/integrations/salesforce/
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Step3. Then click on "Switch to Salesforce Classic" as shown below.

Now, you just need to follow these simple steps mentioned below to integrate ProProfs Chat
with Salesforce.

Follow these steps for Salesforce security token:

Step 1: Click Setup on the top right-hand side of the Salesforce page

Step 2: Now, go to the left-hand side menu, Build→Customise→Lead→Fields.
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Step 3: 

Create a new field with data type Text Area (Long).

  

Name the field "Chat Transcript" in the Field Label box. Then, Press Next
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Set the field level security and then Press Next.
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Click on Save.

 
Step 4:

Then go to User→My Settings
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Personal→Reset my Security Token and click on “Reset Security Token”.

Step 5: Now check your mail, you will find the “Security Token” in the mail. 

Step 6: Login to ProProfs Chat. Then Settings → Integration. Next, enable Salesforce.
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Step 7: Click on Manage and Enter Your User ID, Password and Security Token then click on
Save.

Step 8: After integration, whenever a lead is generated, the user details would be available in
Salesforce.

Related Articles:Related Articles:

MS Dynamics Integration With ProProfs Live ChatMS Dynamics Integration With ProProfs Live Chat
Infusionsoft Integration With ProProfs Live ChatInfusionsoft Integration With ProProfs Live Chat
Nutshell Integration With ProProfs Live ChatNutshell Integration With ProProfs Live Chat

http://chathelp.proprofs.com/ms-dynamics-integration
http://chathelp.proprofs.com/infusionsoft-integration
http://chathelp.proprofs.com/nutshell-integration
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Zoho CRM Integration with ProProfs Live Chat
ProProfs live chat application provides seamless integration with Zoho CRM, the popular CRM platform.
Now all your chat sessions and visitor information can be stored in Zoho CRM directly with just simple
integration.
Follow these step to integrate ProProfs with Zoho CRM.

Log in to your Zoho CRM account.

 

Click on Setup from the top link

https://www.proprofs.com/chat/integrations/zoho/


Live 2 support help
ProProfs Chat FAQs CRM

Copyright © 2014 ProProfs Page 192

Now go to Developer space→CRM API and click on (To manage your authentication tokens, click here).
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Now you authentication token or Zoho CRM API will be generated.

Now Login into your ProProfs Chat control panel.
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Click on CRM Integration.

Checkmark the “Enable Zoho CRM Button.” Then enter your Salesforce login iD, and password also enters
the security token of your sales force account and click on “Save changes.”

Go to MIS Reports→Visitor Chat Transcripts into the ProProfs control panel. Then click on View the chat
transcript. In the bottom of the webpage, you can see the button of “Send to Zoho CRM.”
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Now you can see that your chat session is posted to your Zoho CRM account.

Go to your Zoho CRM account and you able to see the lead for chat transcript.

There you can see your all imported chat session. 
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Related Articles:Related Articles:
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MS Dynamics Integration With ProProfs ChatMS Dynamics Integration With ProProfs Chat
Infusionsoft Integration With ProProfs ChatInfusionsoft Integration With ProProfs Chat
Salesforce Integration With ProProfs ChatSalesforce Integration With ProProfs Chat

http://chathelp.proprofs.com/ms-dynamics-integration
http://chathelp.proprofs.com/infusionsoft-integration
https://chathelp.proprofs.com/sales-force-integration
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Sugar CRM Integration with ProProfs Live Chat
ProProfs live chat application provides seamless integration with Sugar CRM, the popular CRM platform that
has come to be known as the flagship of the open source movement. Now all your chat sessions and visitor
information are automatically stored in Sugar CRM with just simple integration.
Follow these step to integrate ProProfs with Sugar CRM.

You need to download the module for Sugar CRM ( Download ).

Log in to your Sugar CRM. Click the “Admin” area.

Then go to “Module Loader” in the Development Tool Section.

https://www.proprofs.com/chat/integrations/sugarcrm/
http://Live2Support.com/onlinehelp/plugins/sugarl2schat.zip
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Browse the file and upload ProProfs Chat module in Sugar CRM.

Now install the module in Sugar CRM.
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After installation, a Live Chat Link will appear in “All” tab. There you can see all the fields related to the
chat transcript.
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Download the PHP script file ( Download ) and change Sugar CRM path in the PHP file then upload this
script on your server.

Login into ProProfs control panel. Go to “Preferences & Settings→3rd Party Integration”.

http://Live2Support.com/onlinehelp/plugins/sugarscript.rar
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Click on the “Chat transcript” tab. There is an option of “Enable & disable Message” select the “Enable”
Button.

Place your website address in “Host” option and the Name of the file of sugar CRM that you upload on
your server in “Script Path” option.

In “Port” you can leave it at “Default” HTTP, If you want the HTTPS connection then select the “Secure”
mode.

Then click on “Check connection” an “Save changes.”

Now all the chat session will automatically store in your Sugar CRM account.Now all the chat session will automatically store in your Sugar CRM account.
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InfusionSoft Integration with ProProfs Live Chat
InfusionSoft is a complete sales and marketing automation software suite to help small businesses make
their sales and marketing process simple. With its powerful features of CRM, Email and Social Marketing, it
helps businesses streamline their processes, create targeted campaigns and boost sales. InfusionSoft is
used by thousands of small businesses around the globe.
Redefine the way you serve your customers with the combination of InfusionSoft and ProProfs
Deploying our Live Chat solution with InfusionSoft helps you deepen your relationships with the customers in
many ways. ProProfs Chat brings together everything you need into a Live Chat solution to provide
excellent customer service.
With Infusionsoft ProProfs integration, chat transcript will be posted to your infusion soft account at the end
of every chat session.

How to integrate ProProfs Chat with InfusionSoft?
We have made the integration process of ProProfs Chat with different CRMs and other applications are totally
hassle-free and quick. It takes not more than 10 minutes to enjoy live chat facility into your InfusionSoft
system. To get started.
For this, Following details are required.

Application Name

API Key

Action ID

Step 1.
First, you need to log in your InfusionSoft account for above details.

https://www.proprofs.com/chat/integrations/infusionsoft/
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Step 2.
Get Application Name: Your InfusionSoft account denotes your application name. For example, if your
Infusion soft URL is: myapp.infusionsoft.com, then “myapp” is your Application Name.

Step 3.
Get API KEY: See following screens to see how to get API Key
Click on Admin Setting

Now click on Application



Live 2 support help
ProProfs Chat FAQs CRM

Copyright © 2014 ProProfs Page 206

Step 4.
Create Action ID:
After getting the API key, You need to create action ID to assign the chats to users. For this, You need to go
CRM section settings (See following screen).

Now click on Action “Action Set” to create the new action for Chat transcripts.
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Now do the following settings during action set creation (See following screens)
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Action ID will be in numeric i.e. 135
Step 5.

Now Login into ProProfs Control Panel1.

Go to Control Panel→ Preferences Settings → CRM Integration2.

Check Radio button of InfusionSoft CRM3.

Enter Your Application name Name, API Key, Action ID and Leave Chat Transcript field blank then click4.
on Save Change
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Once you save the details, InfusionSoft Integration is done.
Now Do the test chat and close it. You will see the chat transcript in contact (Search with email) in “Notes”
Section of that contact.
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FogBugz Integration with ProProfs Live Chat
FogBugz is a leading bug tracking system to help developers and teams roll out software by meeting
deadlines, cooperating with teammates, maintaining control of the projects and integrating with source
control. It also helps you eliminate hidden risks, make clear decisions and estimate your projects
appropriately.

Extend your FogBugz's capability with ProProfs integration
ProProfs offers a powerful and easy to use chat solution to help organizations provide most convenient chat
support service to their customers. With ProProfs Chat and FogBugz integration; you can reply instantly to
common problems through chat. Live chat solution from ProProfs comes with a flexible pricing option to
enable you to opt for the most fitting choice for your business.

How to integrate ProProfs with FogBugz?
Our chat solution has helped many organizations to deliver excellent customer support service through live
chat consistently. Integrating ProProfs Chat with other systems is so easy and quick. It offers a prompt Add-
on to set up live chat facility into your FogBugz system. You just follow the below steps, and you are all set to
start managing chat in your FogBugz CRM system.
Step 1. First download API library for FogBugz and make a script using that library. Upload the script file and
library file on your server.
Step 2. Now Login into ProProfs control panel and go to “3rd Party Integration” Option

Step 3. Enter API Script URL into chat transcript and offline messages (Host Name and script path)

https://www.proprofs.com/chat/integrations/fogbugz/
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Step 4. Click on Save Change
Step 5. Now Login into your FogBugz CRM account and able to see the transcript as new cases.
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Microsoft Dynamics 365 Integration with ProProfs
Live Chat
ProProfs Chat Integration with MS Dynamics 365  helps in reaching out to website visitors
proactively to drive more sales. Use Microsoft Dynamics 365 CRM to assemble leads and
cases, expand email marketing lists and monitor sales!
Access Leads in MS Dynamics 365: Integration allows you to view leads and cases from chat
in the MS Dynamics 365 CRM. Here is an example of how it appears.
     

Live Chat Transcript: Access chat transcripts from MS Dynamics, e.g.,  Roger Harmanson is
a lead from chat you can view his details along with the chat transcript.

This integration has the following benefits:

Drives up sales by adding new leads in CRM automatically for your sales reps.

Reduce the time and cost of data capture. By automatically having the case and lead
information in Microsoft Dynamics CRM.

https://www.proprofs.com/chat/integrations/microsoft-dynamics/
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Add additional levels of productivity to sales, marketing, and customer service departments.

Enhance personalized conversation by having full access to cases and contacts.

Track your website visitors' IP address using ProProfs visitor monitoring feature.

Send Callback requests to the MS Dynamics CRM.

Requirements For On-premise:

The server must be https enabled.1.

Prefer to choose a domain (e.g., https://proprofs.api.crm.dynamics.com) instead of the2.
path (https://proprofs.api.crm.dynamics.com/integration) to install the MS Dynamics CRM.

Login using Microsoft Dynamics CRM Username which has Admin rights. 3.

To store contacts in the CRM, you need to add Name and Email field in the pre-chat form4.
(URL: https://s01.live2support.com/cpn/index.php#page/prechat)

To Integrate MS Dynamics 365 with ProProfs chat, you will need an organization service
URL. Follow these steps to get the URL from MS Dynamics 365 

Step 1: Log in to your MS Dynamics portal with your credentials.
Step 2: After logging in, copy the highlighted part of the URL.
 

How to Integrate ProProfs Chat with MS Dynamic CRM

Step 1: Log in to ProProfs Chat.
Step 2: Go to Settings---->Integration.
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Step 3: Click to enable Microsoft Dynamics. 
Enter Domain URL (copied part of the URL in Step 2), User ID/Email, Password, Token, or tick
On-Premise (if you want to integrate ProProfs Chat with Microsoft Dynamics CRM On-
Premises). You can also enable lead, case and contact creation instantly. Once done,
click Save.

Step 4: After completing this integration, the user data (Name, Email, Phone Number) from
ProProfs Chat will get added to MS Dynamics as Leads. Here is how your leads will appear in
the MS Dynamics CRM.
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Nutshell Integration with ProProfs Live Chat
Nutshell integration is an upgraded web-based application which allows you to work effectively
as well as efficiently to save your time. It also helps you to manage your business leads,
contacts and accounts. With ProProfs and Nutshell CRM integration your transcripts would be
sent to Nutshell automatically and logged as activities. The main feature of this integration
includes it's smooth and easy to use interface with a powerful management tool. Android and
iPhone apps both include Nutshell's detailed sales analytics data.

The salient features of this powerful integration include:
The reports or data is easy to store

Powerful sales transcript automation

Track your leads and sales representative's activities

It can be integrated with Google applications

Follow These Steps For Nutshell CRM Integration With ProProfs
Chat:

Step 1: Login to your Nutshell account and go to Your Settings.

https://www.proprofs.com/chat/integrations/nutshell/
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Step 2: Then, under the Connections Tab, Select API Keys.

Step 3: Click Add API key. Give the API key a name and click New API Key. Make sure the
permission given is API+ user impersonation.

Step 4: Open the newly formed API Key by clicking it. Next, copy the API address.

Step 5: Next login into your ProProfs Chat Account and go to Settings----->Integration.
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Step 6: Enable Nutshell under Integration. Next, enter your Nutshell User ID and the copied API
Key. Click on Save.

Step 7: You can then see your contacts by clicking the People icon in your Nutshell dashboard.
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CMS
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Add ProProfs Live Chat to Wordpress Website
ProProfs Chat plugin for WordPress is a live chat plugin that one can use to add customer
support to their website. This is the best live chat software which helps you to connect with
website visitors and existing customers. With our live chat plugin for WordPress, we not only
help you increase your leads but also boost customer delight.
 
 Here's how the ProProfs Chat will appear on your WordPress website:

 
Follow these steps to install ProProfs Chat on your WordPress site:
 
Step 1. Navigate to the Plugins section in your “WordPress dashboard.”

https://www.proprofs.com/chat/integrations/wordpress/
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Step 2. Click the “Add New" button.

Step3. Enter “ProProfs Chat ” in the search section. You will find ProProfs Chat – Live Chat
Plugin for WordPress Website. Click the “Install Now” button to proceed.

 
Step 4. When the installation is successfully completed click the “Activate button.”
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Step 5. Navigate to the plugins section and click the “Settings” button under the ProProfs Chat
plugin. 

Step 6. Login to your ProProfs Chat account with your valid credentials.
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Step 7. You will get the following response once the integration is complete.You can click Go To
Dashboard option to go to your Chat dashboard.
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Add ProProfs Live Chat To A Wix Website
Wix is a versatile cloud-based website builder that lets you create and customize a website.
ProProfs Live Chat supports integration to a Wix based website. Integrating Live Chat with Wix
lets you engage with visitors directly through chat.
You can start conversations in real time, thereby improving customer service and also
simultaneously providing customer support where needed. You can initiate conversations
through greetings and also notify visitors about upcoming changes through chat
announcements.
How your Wix website will look after Live Chat Integration:

Here's How You Can Integrate ProProfs Live Chat With Your Wix
Website:

Step 1: Login to ProProfs Chat.
Step 2: Navigate to Settings and click the Installation tab. Copy the Chat Installation Code.
 

https://www.proprofs.com/chat/integrations/wix/
https://chathelp.proprofs.com/chat-greetings
https://chathelp.proprofs.com/chat-greetings
https://chathelp.proprofs.com/what-are-announcements
https://chathelp.proprofs.com/what-are-announcements
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Step 3: Login to your Wix account. Go to the Wix Website Editor and Click on the Add tab (it’s
the plus sign on the menu to the left in WIX editor). Then click More at the bottom of the list.
 

 
Step 4: Click on HTML Iframe and then Click on Enter Code. A new window will open up. Paste
the ProProfs Live Chat Code here. Once done, Click on Apply.
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Step 5: You have to 'resize' the HTML box. Click the HTML box to select and highlight it. Then,
change the size (Width: 350 and Height: 410) from the settings toolbar. The box is now big
enough for the chat window to expand when clicked.
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Step 6: Right-click and select Pin to screen.  Set the position to bottom right corner of your
website or select a location of your choice for the chat window to appear.
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Step 7: Save the changes and click Preview from the top right of the Wix dashboard. Check the
chat window. To sync the Wix website with ProProfs chat go back to the editor and click
Publish.
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Add ProProfs Live Chat to Drupal ver 8.x Website
We provide free trial to enjoy the ultimate benefits of ProProfs live chat and Drupal integration on your
website.
* Download the Module file for Drupal Ver 8.xxx.
To setup live chat on your Drupal CMS you need to :

First login into your control panel to get codes for live chat.1.

Go to Extend section then click on Install new module button.2.

Choose ProProfs Chat downloaded module file and install3.

https://www.proprofs.com/chat/integrations/drupal/
https://www.Live2Support.com/onlinehelp/plugins/live2support_drupal8.zip
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Once Module is installed. Block for live chat will be created. Now go to Structure→ block, See following screen
for block section.
click on “Place Block” Either in footer OR place where you want to display chat icon. select ProProfs Block
and place block.
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Now you need to configure ProProfs block after selecting the section (i.e. Footer first) where you want to
place block.

During configure live chat, you need to place the ProProfs codes, which you already have from
ProProfs control panel. Leave “Display Title” blank.
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Drupal integration has been completed. Chat icon will be on your website.
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Add ProProfs Live Chat to Drupal ver 6.x & 7.x
Website
We provide free trial to enjoy the ultimate benefits of live chat on your Drupal website.
To setup live chat on your Drupal CMS you need to :

First download the plug-in of our live chat.1.

Then login into your control panel to get codes for live chat plug-in.2.
Click Here for Chat integration on Drupal 8.xxx

Download the Module file for Drupal-6.xxx.

Download the Module file for Drupal-7.xxx.

Then right click on that ProProfs Chat live chat zip file and unzip the live chat plug in to proceed
further.

Go to (l2schat folder) in that folder you will find a text file of “l2scode.txt”.

Edit that file and copy the codes from ProProfs Chat control panel and paste that codes in that file.
Then save that file.

https://www.Live2Support.com/onlinehelp/plugins/live2support-drupal6.zip
https://www.Live2Support.com/onlinehelp/plugins/live2support-drupal7.zip
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copy l2schat folder into drupal→sites→all→modules.

Go to Modules and check mark l2schat module, Then click save configuration.

Then Go to Structure → Blocks.

Then Go to Blocks → Disabled section and find Live Chat.

Finally set position for your live chat icon.
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Add ProProfs Live Chat to Squarespace Website
Step 1:  Navigate to settings and then click on the “installation” tab and copy the chat installation code, click
on “copy to clipboard” to copy the code.

Step 2: Login to your SquareSpace Admin section.
Step 3: Navigate to “settings.”
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Step 4: Navigate to “advanced.”

Step 5: Navigate to “Code Injection.” Now scroll down to the “Footer .” Paste the ProProfs chat code in the
footer box, then click on “Save Settings” to save the chat code.

Here's how your SquareSpace website would look after completing the above steps:
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Add ProProfs Live Chat to Weebly
Website
Step 1: Navigate to settings and then click on the “installation” tab and copy the chat

installation code, click on “copy to clipboard” to copy the code.

 

 

Step 2:  Login to your Weebly administrator account with your valid credentials.

   https://www.weebly.com/login

https://www.weebly.com/login
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Step 3: Navigate to Weebly’s site editor https://www.weebly.com/editor/main.php click

on Build option and then on select Embed code option after click, drag and drop this

option to website’s footer section. Click on add custom HTML option and then go to Edit

custom HTML.

 

https://www.weebly.com/editor/main.php
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Step 4: Now paste the ProProfs chat installation code and click on Publish button to

save the changes.

 

Step 5: Visit your website to see the ProProfs chat.
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Add ProProfs Live Chat to Joomla Website
Step 1:  Log in to your ProProfs Chat account and navigate to "Settings."
Step 2: Locate and Click the "Installation" tab, then click "Copy to Clipboard" to copy the chat Installation code.

Step 3:  Click Here to download the plug-in application. Right-click the ProProfs Live Chat zip file and Unzip
the live chat plug-in to proceed further.

Step 4(i): Navigate to (mod_proprofschat ) to find a text file of “chatcode.txt.”

(ii):  Open the file to paste the “ProProfs chat code” to it, save the file after implementing the changes.

(iii): Go to the main folder (mod_proprofschat), Right-click the folder, hover on "Send to" → Select Compressed

https://www.proprofs.com/chat/downloads/plugins/Joomla/mod_proprofschat.zip


Live 2 support help
ProProfs Chat FAQs CMS

Copyright © 2014 ProProfs Page 250

(Zipped) folder. Congrats! You have successfully executed your ProProfs chat plug-in.

Step 5(i): Login to your Joomla admin account to get started.

(ii): Navigate to “Extensions” → Manage, and click “install.”

(iii): Browse the plug-in you have downloaded and edited, and upload the “mod_proprofschat.zip” file.
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(iv):  After the successful upload of the module, navigate to “Extensions → Modules.” Select the ProProfs Chat
Module and click "Edit."

(v):  In the options menu select "Module" section. Choose the position, status, access, and ordering of the
module where you want to display the chat box on your Joomla website. Click “Save” to secure and
implement the settings and publish the module.



Live 2 support help
ProProfs Chat FAQs CMS

Copyright © 2014 ProProfs Page 252

(Vi):  Refresh your website to check the ProProfs Chat enabled on your Joomla website.
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Add ProProfs Live Chat to DotNetNuke Website
You need to follow these steps to integrate ProProfs Chat software with DotNetNuke.

Login to ProProfs control panel.

Click on Get Codes to Insert in Your Webpages under Codes & Graphics for Your Webpage.

Choose Codes for Graphics Status Display (Default).

Click on “Get code” option & copy those codes.

Login to your Dotnetnuke admin panel and go to Edit mode.

Go to Modules section and choose appropriate options on module section and module location.

https://www.proprofs.com/chat/integrations/dnn-software/
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Click on Add Module button.

Module will appear on your page.

Now click on Live Chat module Manage → Setting.
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Insert code into Advance setting –> footer section and click on update button.
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Live Chat Appear on your website. You have added live chat into DotNetNuke successfully.
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LightCMS Integration with ProProfs Live Chat
You need to follow these steps to integrate ProProfs Chat with Light CMS.

Login to ProProfs control panel.

Click on Get Codes to Insert in Your Webpages under Codes & Graphics for Your Webpage.

Choose Codes for Graphics Status Display (Default).

Click on “Get code” option & copy those codes.

Login to your Light CMS account & click on Design.

 

Select Option Menu.

https://www.proprofs.com/chat/integrations/lightcms/
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Then go to Edit Source from the following options.

 

Select page from right bar menu in which you want to place the code.

Place your ProProfs codes into that page.
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Select Click on Save.

Live Chat Appear on your website. You have added live chat into Light CMS successfully.
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Drupal ver 6.x & 7.x Integration With ProProfs Live ChatDrupal ver 6.x & 7.x Integration With ProProfs Live Chat
SquareSpace Integration With ProProfs Live ChatSquareSpace Integration With ProProfs Live Chat

https://chathelp.proprofs.com/drupal-ver-8-x-integration
https://chathelp.proprofs.com/drupal-ver-6-x-7-x-integration
https://chathelp.proprofs.com/drupal-ver-6-x-7-x-integration
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Kentico Integration with ProProfs Live Chat
Integrating ProProfs with your Kentico CMS based website enables you to provide excellent support to your
customers via live chat.
Our live chat's exciting features and user-friendly functionality helps you discover more possibilities for
customer delight.
Here's how your Kentico website will look after completing this integration: 

Step1. From your ProProfs Chat dashboard, navigate to settings and click on installation. Copy the
installation code. (see image below)

https://www.proprofs.com/chat/integrations/kentico/
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Step2. Now, Login to your Kentico CMS admin panel. 
Step3. Navigate to "Edit Layout" section. (see image below)

Step 4. Paste ProProfs Chat as shown in the image below and click on "Save". 
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Step5. ProProfs Chat is now ready to delight customers on your Kentico website.

 

Related Articles:Related Articles:

WordPress Integration With ProProfs Live ChatWordPress Integration With ProProfs Live Chat
Weebly Integration With ProProfs Live ChatWeebly Integration With ProProfs Live Chat

https://chathelp.proprofs.com/live-chat-in-wordpress
https://chathelp.proprofs.com/live-chat-weebly-integration
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DotNetNuke Integration With ProProfs Live ChatDotNetNuke Integration With ProProfs Live Chat

https://chathelp.proprofs.com/live-chat-in-dotnetnuke
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WHMCS Integration with ProProfs Live Chat
The WHMCS is one of the largest providers of frequent billing software for customer support services. It can
recognize a registered client and get direct access to their ticket, profile and other specific information from
chat interface. The chats are logged under WHMCS ticket history; it can detect if a site visitor is logged into
your WHMCS installation and hence provides links to diverse WHMCS functionality. The link allows opening
the WHMCS web area to view a client's summary, view orders, manage products and services, invoices,
emails, view or edit support tickets.
ProProfs and WHMCS integration is studded with powerful features:

You can send high quality, customized and professional looking invoices.

PDF versions can be attached, including invoice notification and payment reminder notices

You can invoice or bill your customers in multiple currencies

WHMCS is all about integration and automation, it manages emails, password change, upgrades,
suspensions and more

It provides automated billing which features automatic invoicing, payment processing, transaction logging,
payment reminders, refund and cancelation of mass scale billing

With WHMCS you have all the product configuration options and functionality you need to run a
successful and automated online business

It offers products which can be customized when ordering and also offer a wide range to choose from

It lets you manage domain purchases in an automated way, The WHMCS web area gives its user all the
tools they need from a domain registrar

Domain locking can be performed to protect data from transferring

It support to post your latest news and updates on your websites

It can be installed quickly and readily

Multiple languages

Android Applications and iPhone are available

It has a portal look, but can be integrated as much or as little as you want

Step 1.
Go to ProProfs Control Panel→ Preferences Settings → CRM Integration

https://www.proprofs.com/chat/integrations/whmcs/
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Step 2.
Select WHMCS from option
Step 3.
Enter Your User ID , Password and WHMCS Api URL(Example : http://yourdomain.com/includes/api.php) then
click on Save Change

Step 4.
After Integration you will get new Ticket of Live Chat Transcript
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Related Articles:Related Articles:

Wix Integration With ProProfs Live ChatWix Integration With ProProfs Live Chat
Light CMS Integration With ProProfs Live Chat Light CMS Integration With ProProfs Live Chat 
Kentico Integration With ProProfs Live ChatKentico Integration With ProProfs Live Chat

https://chathelp.proprofs.com/wix-integration
https://chathelp.proprofs.com/live-chat-in-kentico
https://chathelp.proprofs.com/live-chat-in-kentico
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E-commerce
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3dcart Integration with ProProfs Live Chat

Live Chat with 3D Cart
Follow these steps for ProProfs Chat and 3D Cart integration:

Login to ProProfs control panel.

Click on Get Codes to Insert in Your Webpages under Codes & Graphics for Your Webpage.

Choose Codes for Graphics Status Display (Default).

Click on “Get code” option & copy those codes.

Login to the admin panel of your 3D Cart Account & click on Design Your Store.

Select Edit Template (HTML).

https://www.proprofs.com/chat/integrations/3dcart/
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Click on frame.html or home.html Edit.

 

Place your ProProfs codes into the frame.html or home.html content box.
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Select Click on Save.

 

Click on View Store, live chat icon will be displayed on your web page.
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Related Articles:Related Articles:

Adding ProProfs Live Chat in ShopifyAdding ProProfs Live Chat in Shopify
Adding ProProfs Live Chat in MagentoAdding ProProfs Live Chat in Magento
Adding ProProfs Live Chat in Spark Pay Adding ProProfs Live Chat in Spark Pay 

https://chathelp.proprofs.com/adding-live2support-live-chat-in-shopify
https://chathelp.proprofs.com/magento
https://chathelp.proprofs.com/spark-pay
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BigCommerce Integration with ProProfs Live Chat

Live Chat in BigCommerce
Follow these steps for ProProfs and BigCommerce integration:

Login to ProProfs control panel.

Click on Get Codes to Insert in Your Webpages under Codes & Graphics for Your Webpage.

Choose Codes for Graphics Status Display (Default).

Click on “Get code” option & copy those codes.

Login to the admin panel of your BigCommerce & click on Settings →> Design

 

Now Click on Edit HTML/CSS.

https://www.proprofs.com/chat/integrations/bigcommerce/
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Select Header File from Left side list of file and Save the file.

 

Click on View Store, live chat icon will be displayed on your web page
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Related Articles:Related Articles:

Adding ProProfs Live Chat in ShopifyAdding ProProfs Live Chat in Shopify
Adding ProProfs Live Chat in MagentoAdding ProProfs Live Chat in Magento
Adding Live Chat in CS-CartAdding Live Chat in CS-Cart  

https://chathelp.proprofs.com/adding-live2support-live-chat-in-shopify
https://chathelp.proprofs.com/magento
https://chathelp.proprofs.com/cs-cart
https://chathelp.proprofs.com/cs-cart
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CoreCommerce Integration with ProProfs Live
Chat

Live Chat in CoreCommerce
Follow these steps for ProProfs Chat and CoreCommerce integration:

Login to ProProfs control panel.

Click on Get Codes to Insert in Your Webpages under Codes & Graphics for Your Webpage.

Choose Codes for Graphics Status Display (Default).

Click on “Get code” option & copy those codes.

Login to the admin panel of your CoreCommerce.

 

Now Go To Design→Advance Option.

https://www.proprofs.com/chat/integrations/corecommerce-live-chat-plugin/
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Choose file from Select a file to edit option
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Place your ProProfs codes into the header.html or Selected File content box.
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Select Click on Publish.
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Now go to Your Store, live chat icon will be displayed on your web page.
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Related Articles:Related Articles:

Adding ProProfs Live Chat in OpenCartAdding ProProfs Live Chat in OpenCart
Adding ProProfs Live Chat in MagentoAdding ProProfs Live Chat in Magento
Adding ProProfs Live Chat in osCommerceAdding ProProfs Live Chat in osCommerce

https://chathelp.proprofs.com/opencart
https://chathelp.proprofs.com/magento
https://chathelp.proprofs.com/oscommerce
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CS-Cart Integration with ProProfs Live Chat

Live Chat in CS-Cart
Bring together ProProfs live chat solution expertise with your CS-Cart based E-commerce website gives you
the ultimate solution to engage with your customers in real-time. Integrate ProProfs Chat with CS Cart to
provide real time customer support and monitor your website visitors at your maximum comfort. Turn
opportunities into solid leads with ProProfs Chat.
How to integrate ProProfs with CS-Cart?
You can integrate ProProfs live chat to your CS-Cart website in just minutes without any hassle. What you
need to do is just follow the below steps:
Step 1. Log into ProProfs Control Panel.
Step 2. Click Get Codes to Insert in your web page under Codes & Graphics for your webpage.
Step 3. Choose Codes for Graphics Status Display (Default).
Step 4. Click Get Code option & copy those codes.
Step 5. Log into admin of Cs-cart store.

Step 6. Then go to upper menu design→layout

https://www.proprofs.com/chat/integrations/cscart/
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Step 7. Now go to Manage Block and create new html block and add ProProfs live chat code in content
section
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Step 8. After that you add this block into your layout section
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Step 9. Now live chat ready for your cs-cart store/website

Related Articles:Related Articles:

Adding ProProfs Live Chat in ShopifyAdding ProProfs Live Chat in Shopify
Adding ProProfs Live Chat in MagentoAdding ProProfs Live Chat in Magento

https://chathelp.proprofs.com/adding-live2support-live-chat-in-shopify
https://chathelp.proprofs.com/magento
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Adding ProProfs Live Chat in PrestaShopAdding ProProfs Live Chat in PrestaShop

https://chathelp.proprofs.com/add-live-chat-in-prestashop


Live 2 support help
ProProfs Chat FAQs E-commerce

Copyright © 2014 ProProfs Page 294

Add ProProfs Live Chat to Your Magento Website
It's easy to integrate ProProfs Chat to your Magento website. Once you complete this integration, you can
offer support to your customers by chatting with them in real time, monitor visitors, capture leads and much
more. 
This is how a Magento site will look like after adding ProProfs Chat:

To perform this integration, follow these simple steps: 
Step1. Login to your ProProfs Chat account.
Step2.  Navigate to "Settings" and click on "Installation". Copy the chat installation code. (Refer to the
screenshot below)

https://www.proprofs.com/chat/integrations/magento/
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Step3. Now, login to your Magento account. 
Step4. From your Magento dashboard, navigate to "Store" followed by "Design". Then, go to HTML head
option and paste ProProfs Chat code in the "Miscellaneous Scripts". Save changes.

Related Articles:Related Articles:

Adding ProProfs Live Chat in ShopifyAdding ProProfs Live Chat in Shopify
Adding ProProfs Live Chat in VolusionAdding ProProfs Live Chat in Volusion
Adding ProProfs Live Chat in X-CartAdding ProProfs Live Chat in X-Cart

https://chathelp.proprofs.com/adding-live2support-live-chat-in-shopify
https://chathelp.proprofs.com/adding-live2support-live-chat-in-volusion
https://chathelp.proprofs.com/adding-live2support-live-chat-in-x-cart
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OpenCart Integration with ProProfs Live Chat

Adding ProProfs Live Chat in OpenCart
You need to follow these steps to integrate ProProfs Chat Software with OpenCart. These steps will help you
in adding ProProfs Chat Button on your OpenCart page.

Download the plug-in application.

Download the plug-in application.

Then right click on that live chat zip file and unzip the live chat plug in to proceed further.

 

Simple, Place the following files in right directories.

admin/controller/module/l2s_livechat.php
admin/language/english/module/l2s_livechat.php
admin/view/template/module/l2s_livechat.tpl

catalog/controller/module/l2s_livechat.php

https://www.proprofs.com/chat/integrations/opencart/
http://Live2Support.com/onlinehelp/plugins/l2sopencart2.x.zip
http://Live2Support.com/onlinehelp/plugins/l2sopencart1.x.zip
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catalog/language/[english]/module/l2s_livechat.php
catalog/view/theme/[default]/template/module/l2s_livechat.tpl

Log into the admin section of your OpenCart Site e.g yoursite.com/admin.

Select Extensions - > Modules and click install on ProProfs Live Chat.

 

Extensions - > Modules and click Edit on ProProfs Live Chat.
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Place Your Live Chat Code into ProProfs Live Chat Code text area.
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After place code, status should be active and save changes.
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Then Select System- > Design → Layouts and configure module to show in which template section.
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In Edit Layout section add new module set module, position, sort order and save changes.
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Save Your Current change configuration.

Related Articles:Related Articles:



Live 2 support help
ProProfs Chat FAQs E-commerce

Copyright © 2014 ProProfs Page 303

Adding ProProfs Live Chat in ShopifyAdding ProProfs Live Chat in Shopify
Adding ProProfs Live Chat in MagentoAdding ProProfs Live Chat in Magento
Adding ProProfs Live Chat in ZenCartAdding ProProfs Live Chat in ZenCart

https://chathelp.proprofs.com/adding-live2support-live-chat-in-shopify
https://chathelp.proprofs.com/magento
https://chathelp.proprofs.com/steps-to-integrate-live2support-live-chat-in-zencart-pages
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Add ProProfs Live Chat to Your osCommerce
Website
Add more power to your business with ProProfs Chat and osCommerce integration.
Offer live chat support to your customers, reduce the shopping cart abandonment, monitor visitor behavior,
capture leads and more.
Here's how your osCommerce website would look with ProProfs Chat:

This integration enriches following features:

Avail all kinds of offers and discount coupons through live chat.

Get foot prints of the visitor locations.

Update your visitor with new product launch, offers on key items and shipping details.

Instant view of the pages being browsed by the visitor.

Engage customers and reduce shopping cart abandonment.

Follow these simple steps to Integrate ProProfs Chat with your osCommerce website:
Step1. Login to ProProfs Chat.
            
Step2. Navigate to Settings and then click on "Installation", Copy the chat installation code.
 

https://www.proprofs.com/chat/integrations/oscommerce/
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Step3.  Upload "bm_l2s_chat.php to /catalog/includes/modules/boxes/" via ftp. Download plugin

Step4. Login to your osCommerce administration panel.
Step5. Navigate to Modules → Boxes.

 Step6. Install live chat module.

https://www.proprofs.com/chat/downloads/plugins/ProProfs_chat_oscommerce.zip
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Step7. Edit "Live Chat module" settings and paste HTML button code.

Step8. Save and Enable the module and ProProfs Chat will be displayed on your online shop.
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Related Articles:Related Articles:

Adding ProProfs Live Chat in 3D Cart IntegrationAdding ProProfs Live Chat in 3D Cart Integration
Adding ProProfs Live Chat in MagentoAdding ProProfs Live Chat in Magento
Adding ProProfs Live Chat in Spark PayAdding ProProfs Live Chat in Spark Pay

https://chathelp.proprofs.com/3d-cart
https://chathelp.proprofs.com/magento
https://chathelp.proprofs.com/spark-pay
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How to Add Live Chat to PrestaShop Website
Here's how your PrestaShop would look like with ProProfs Chat:

You need to follow these steps to integrate ProProfs Chat Software with PrestaShop. 
Step1. Download the plug-in application.
 
Step2.  Login to your PrestaShop administrator account with  valid credentials.
Step3. Navigate to "Improve" section, Click on "Modules & Services". Click on Upload a Module button to
upload ProProfs live chat plugin.  

https://www.proprofs.com/chat/integrations/prestashop/
https://www.proprofs.com/chat/integrations/prestashop/
https://www.proprofs.com/chat/downloads/plugins/ProProfs_chat_prestashop.zip
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Step4. Click on Select file link and upload ProProfs live chat plugin for PrestaShop.

Step5. Navigate to installed modules and then click on configure button to edit module and insert ProProfs
Chat code.

Step6. Choose position to show the ProProfs Chat on your store. Paste ProProfs Chat code into text area and
click on Save Settings button.
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Step7.  Now you can chat with customers on your PrestaShop website.
                    

                     
Note* To get ProProfs Chat installation code, Go to your ProProfs Chat dashboard, click on "Settings" and
click on "Installation".  

Related Articles:Related Articles:

http://https://www.proprofs.com/chat/login/
http://https://s01.live2support.com/cpn/index.php#page/installation
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Adding ProProfs Live Chat in ShopifyAdding ProProfs Live Chat in Shopify
Adding ProProfs Live Chat in MagentoAdding ProProfs Live Chat in Magento
Adding ProProfs Live Chat in BigCommerceAdding ProProfs Live Chat in BigCommerce

https://chathelp.proprofs.com/adding-live2support-live-chat-in-shopify
https://chathelp.proprofs.com/magento
https://chathelp.proprofs.com/bigcommerce
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Add ProProfs Live Chat to Your Shopify Website
Here's how your Shopify website would look after completing this integration: 

You need to follow these steps to integrate ProProfs Chat Software with Shopify. 
Step1.   Login to ProProfs chat control panel with your valid login credentials.
Step2.   Navigate to "Settings" and then click on the installation, Copy the chat installation code.

               

Step3.  Login to your Shopify account with your valid credentials.

https://www.proprofs.com/chat/integrations/shopify/
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Step4.  Navigate to online store option.

Step5.  Navigate to themes → > Edit HTML/CSS.
              

Step6.  Click on "theme.liquid" option available in the Layout section.
Step7.  Paste your ProProfs Chat code into the "theme.liquid" content box.
Step8.  Then click the save button.

Step9.  Click the preview button, a Live chat window will be displayed on your store’s web page.

Related Articles:Related Articles:

Adding ProProfs Live Chat in CS-CartAdding ProProfs Live Chat in CS-Cart
Adding ProProfs Live Chat in Magento IntegrationAdding ProProfs Live Chat in Magento Integration
Adding ProProfs Live Chat in CoreCommerce IntegrationAdding ProProfs Live Chat in CoreCommerce Integration

https://chathelp.proprofs.com/cs-cart
https://chathelp.proprofs.com/magento
https://chathelp.proprofs.com/corecommerce
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Spark Pay Integration with ProProfs Live Chat

Live Chat in Spark pay
Follow these steps for ProProfs Chat and Spark pay integration:

Login to ProProfs control panel.

Click on Get Codes to Insert in Your Webpages under Codes & Graphics for Your Webpage.

Choose Codes for Graphics Status Display (Default).

Click on “Get code” option & copy those codes.

Login to the admin panel of your Spark pay Account.

 

Now click on Themes →> Edit button..*

https://www.proprofs.com/chat/integrations/sparkpay/
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Click on Footer →> HTML Editor. Place your ProProfs codes into the Selected Section* .

Select Click on Save.
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Click on View Store, live chat icon will be displayed on your web page.
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Related Articles:Related Articles:

Adding ProProfs Live Chat in ShopifyAdding ProProfs Live Chat in Shopify
Adding ProProfs Live Chat in BigCommerceAdding ProProfs Live Chat in BigCommerce
Adding ProProfs Live Chat in CoreCommerceAdding ProProfs Live Chat in CoreCommerce

https://chathelp.proprofs.com/adding-live2support-live-chat-in-shopify
https://chathelp.proprofs.com/bigcommerce
https://chathelp.proprofs.com/corecommerce
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Add ProProfs Live Chat to Your Volusion Website
Follow these steps for ProProfs Chat and Volusion integration:

Login to ProProfs control panel.

Click on Get Codes to Insert in Your WebPages under Codes & Graphics for Your Webpage.

Choose Codes for Graphics Status Display (Default).

Click on “Get code” option & copy those codes.

Login into admin of Volusion CMS store.

Go to Design→Template Section.

 

Click on Edit HTML.

https://www.proprofs.com/chat/integrations/volusion/
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Place code into your template Page.

click on save option and then click on view file
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Live Chat Appear on your website. You have added live chat into Volusion successfully.

Related Articles:Related Articles:

Adding ProProfs Live Chat in ShopifyAdding ProProfs Live Chat in Shopify
Adding ProProfs Live Chat in OpenCartAdding ProProfs Live Chat in OpenCart
Adding ProProfs Live Chat in osCommerceAdding ProProfs Live Chat in osCommerce

https://chathelp.proprofs.com/adding-live2support-live-chat-in-shopify
https://chathelp.proprofs.com/opencart
https://chathelp.proprofs.com/oscommerce
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X-Cart Integration with ProProfs Live Chat
Follow these steps for ProProfs Chat and X-Cart integration:

Login to ProProfs control panel.

Click on Get Codes to Insert in Your WebPages under Codes & Graphics for Your Webpage.

Choose Codes for Graphics Status Display (Default).

Click on “Get code” option & copy those codes.

Login into your X-Cart Admin Panel.

 

Go To Content→Edit Template.

https://www.proprofs.com/chat/integrations/x-cart/
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Select your template folder (Example of template folder given below).

 

Then select customer folder.
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Select appropriate file where you want to place the ProProfs code.
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Place the  code at appropriate place.
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Click on Save Button to reflect change.
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Related Articles:Related Articles:

Adding ProProfs Live Chat in MagentoAdding ProProfs Live Chat in Magento
Adding ProProfs Live Chat in PrestaShopAdding ProProfs Live Chat in PrestaShop
Adding ProProfs Live Chat in VolusionAdding ProProfs Live Chat in Volusion

https://chathelp.proprofs.com/magento
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https://chathelp.proprofs.com/adding-live2support-live-chat-in-volusion
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ZenCart Integration with ProProfs Live Chat
Follow these steps for ProProfs Chat and ZenCart integration:

Download the plug-in application.

Then right-click on that ProProfs live chat zip file and unzip the live chat plugin to proceed further.

 

Go to (zencart→l2s) in that folder you will find a text file of “l2scode.txt”.

Edit that file and copy the codes from ProProfs control panel then paste that codes in that file, After
making the changes please save the file.

https://www.proprofs.com/chat/integrations/zencart/
http://Live2Support.com/onlinehelp/plugins/zencart.zip
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copy l2s folder into Zencart→includes→modules.

Copy l2schat.php into Zencart→includes→modules→sideboxes.

Copy tpl_l2schat.php into Zencart→includes→ templates→template_default→sideboxes.

Login into your Zencart Admin Section to get started.

go to upper menu Tools→Layout Boxes Controller.

 

Click on sideboxes/l2schat.php and set the position of ProProfs live chat.
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Click on update for save the change.

Related Articles:Related Articles:

Adding ProProfs Live Chat in MagentoAdding ProProfs Live Chat in Magento
Adding ProProfs Live Chat in ShopifyAdding ProProfs Live Chat in Shopify
Adding ProProfs Live Chat in X-CartAdding ProProfs Live Chat in X-Cart

https://chathelp.proprofs.com/magento
https://chathelp.proprofs.com/adding-live2support-live-chat-in-shopify
https://chathelp.proprofs.com/adding-live2support-live-chat-in-x-cart
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Helpdesk
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Zendesk Integration with ProProfs Live Chat
ProProfs empowers you to add ProProfs Chat on your Zendesk Help Center. Here's how your Zendesk will
look after integrating ProProfs Chat with it:

Just follow these simple steps to reap the benefits of both top notch tools:
1. Add ProProfs Chat to Zendesk.
2. Send chat transcripts to Zendesk as tickets.
3. Get support emails from Zendesk admin panel.
4. Get Zendesk API token.

Add ProProfs Chat to Zendesk

Step1. Log in to ProProfs chat control panel with your valid credentials.                    
                                                                                                     
Step2. Navigate to "Settings" and then click on the "Installation", Copy the chat installation code.

https://www.proprofs.com/chat/integrations/zendesk/
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Step3. Log in to Zendesk and navigate to your newly enabled Help Center and click on the "Customize Design"
under "Settings".

Step4. Click on the “Edit theme” link to bring up the code editor. 
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Step5.  Select the “footer” option under "Select template". This will allow for you to edit the direct code for the
footer.

Step6.  Paste your ProProfs Chat installation code after </footer> tag. You can click on the "Preview" button
to see the changes in a draft mode of your Help Center page. Click on the "Save" button to save the code.
After you click the "Save" button, you will be taken back to the editor. Click on the "Publish changes" button to
finalize the change and publish to all visitors of your new Help Center.
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Step7.  Now ProProfs Chat will be available to visitors of your Zendesk help center.

Send your chat transcripts and offline messages to Zendesk as
a ticket.
Step1. Log in to ProProfs chat control panel with your valid credentials.   
Step2. To get your chat transcripts as a Zendesk ticket, navigate to "CRM Integration" under "Integration" in
"Settings". Enable the Zendesk toggle by clicking on it.
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Step3. Once you enable Zendesk toggle to "YES", a pop up will appear (see image below). Fill in the
information as instructed below:

Enter your Zendesk Subdomain (Example: https://subdomain.zendesk.com). 

Enter your Registration email address (Email address used to create Zendesk account).

Enter your Zendesk API token.

Enter your Zendesk support email address (Example: support@subdomain.zendesk.com).

Click on Save button to save the credentials.

 Step4. After step 2 and step3 you will get your chat transcript and offline messages as a Zendesk ticket.  
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How to get your Zendesk support email address from Zendesk admin
panel. 

Step1. Click the Admin icon in the sidebar, then select Channels > Email.
Step2. In the Support addresses section, click "Add address", then select "Create new Zendesk address".

Step3. Enter an address you'd like to use for receiving support requests.
Step4. Click "Create now". The email address is added to your list of support addresses.
Step5. Click the Admin icon in the sidebar, then select Channels > Email. Copy your Support email address
(Example: support@yoursubdomain.zendesk.com) from support addresses section, Enable "Accept wildcard
emails" and "Rich content in email" option.
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How to get your Zendesk API token from Zendesk admin panel

Step1. Log in to your Zendesk account. From your dashboard, click on the settings icon. 

Step2. Click on "API" under "Channels". Enable "Token Access" by clicking on the toggle button. Then, click on
"+" icon to add new token. (see image below)
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Step3. A window will pop up. This will contain your Zendesk API token. Just copy and paste it where ever
necessary. (refer to the screenshot below)
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Email-marketing



Live 2 support help
ProProfs Chat FAQs Email-marketing

Copyright © 2014 ProProfs Page 342

ActiveCampaign Integration with ProProfs Live
Chat
ActiveCampaign helps you build your list and manage your contacts more effectively. Using its
contact based features, you will learn the personal & behavioral details of your contacts while
utilizing that data for mass automation sequences, personalized campaigns, and more.
Take your customer support capability to the next level with ProProfs Chat integration.
ProProfs Chat is an industry leading live chat solution that helps organizations to augment their
site's self-service capabilities with live chat. Combining ProProfs Chat's advanced features and
unmatched reliability with ActiveCampaign's rich features; you can achieve a compelling
customer experience with this combined solution. This chat solution is highly scalable and
comes with a flexible pricing option to facilitate you to choose the fitting-choice for your
business.

How To Integrate ProProfs Chat With ActiveCampaign
ProProfs Chat offers a prompt Add-on to integrate live chat facility into ActiveCampaign. Many
organizations rely on our live chat solution to provide real-time chat facility to their customers.
You just follow the below steps, and you are all set to start to manage your campaign with
ActiveCampaign.
Step 1: Login to your ActiveCampaign account and go to the Settings section. There, Click
on Developer. Copy the URL and Key.

https://www.proprofs.com/chat/integrations/activecampaign/
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Step 2: Login to your ProProfs Chat account and go to Settings----->Integration. 
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Step 3: Enable ActiveCampaign under CRM and enter your URL and Key. The List ID is the name
of the contact list that you are transferring to ActiveCampaign. Once everything is done,
click Save.
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How To View Integrated Contacts In ActiveCampaign
There are two ways to view integrated contacts in ActiveCampaign.

Lists: On your ActiveCampaign dashboard, you can select Lists and view your contacts
according to the List ID of the integrated contacts.

Contacts: The contacts option displays the contacts according to the order of their uploads.
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iContact Integration with ProProfs Live Chat
iContact provides professional email marketing solution to get better marketing results. Using its easy-to-use
features, you can make a difference in your marketing campaign. Regardless of your skill level, iContact's
exciting features and tools help you move seamlessly from building lists and designing emails, to sending
messages and tracking opens and clicks.
Go beyond the inbox with ProProfs Chat to pinpoint more business opportunities
Our integrated Live chat solution enables to go beyond email marketing campaign and maximize the impact
of your communication by using live chat. ProProfs Chat makes it easy for you to seamlessly interact with
your existing customers, and track your new visitors for more sales opportunities. Our Live Chat solution's
simple-to-use and flexible features help you improve your customers' experience, and serve more effectively
anywhere and anytime.
How to integrate ProProfs Chat with iContact?
You can create a more intimate iContact integration with ProProfs Chat without any hassle of huge coding.
You just follow the below steps and you are all set to start manage chatting in your iContact contact
management system.
Step 1. First download API library for iContact and make a script using that library. Upload the script file and
library file on your server.
Step 2. Now Login into ProProfs Chat control panel and go to “3rd Party Integration” Option

Step 3. Enter API Script url into pre chat form (Host Name and script path)

https://www.proprofs.com/chat/integrations/icontact/
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Step 4. Click on Save Change
Step 5. Now Login into your iContact account and go to contact section where you can able to see the
contact details in your particular list.
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Account and Billing
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Change Package
You can upgrade your package anytime to go premium. Follow these simple steps to upgrade your
package to any plan of your choice.

Step1: Navigate to "My Account."

Step 2: Click "Change Package" button.

Step 3: You will be redirected to the chat pricing page, select a plan and click "Upgarde" to change your
package.

https://www.proprofs.com/chat/pricing/
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How to Update Your Credit Card Details?
Follow these steps to update your billing details:
Step 1: Navigate to "My Account."

Step 2: Click the "Click here" button for Credit Card Details.

Step 3: Update your billing details and click "Update Billing Details" to secure the changes.
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Submit A Ticket
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